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ABSTRAKSI 

SISTEM INFORMASI GEOGRAFIS UNTUK FASILITAS UMUM BATAM 
GIS(Geographic Information System) atau di Indonesia lebih dikenal dengan SIG(Sistem Informasi 
Geografis) adalah sebuah sistem yang mengelola data geografis. 
 
Semakin pesatnya kemajuan Kota Batam sehingga fasilitas umum yang ada juga bertambah banyak. Saat ini 
sarana penyedia informasi fasilitas umum Kota Batam masih secara manual yang pada umumnya statis. 
Masyarakat yang ingin mencari informasi tentang fasilitas umum melakukan pencarian dari buku atau 
majalah dengan data yang tidak akurat, hal itu akan menyebabkan kesalahan dalam pencarian. Sarana 
penyedia informasi hanya bisa menyediakan informasi yang tidak terkini. Oleh karena itu diperlukam sistem 
informasi yang dinamis, interaktif dan terkini, yang membantu masyarakat dalam mencari data tentang 
fasilitas umum Kota Batam. 
 
Aplikasi ini mengembangkan Sistem Informasi Geografis untuk Fasilitas Umum (SIGFUM) Batam via web 
yang bersifat dinamis dan terkini. Sehingga kelak masyarakat bisa mengakses informasi tentang fasilitas 
umum Kota Batam dalam bentuk grafik pada web browser dan informasi yang didapat lebih terperinci. 
 
Aplikasi ini dibangun menggunakan ArcView 3.0 dan OpenSVGMapServer 1.01. Data atribut maupun data 
spatial dari ArcView akan diexport ke database MySQL sehingga datanya dapat dipanggil melalui web 
browser. Agar aplikasi ini dapat berjalan dibutuhkan Adobe SVG Viewer plugin pada browser. 
 
Kata Kunci: GIS, SIG, Web browser, ArcView 
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BAB 1 PENDAHULUAN 

1.1 Latar Belakang 
Dengan semakin pesatnya kemajuan Kota Batam, fasilitas umum yang ada juga bertambah 
banyak. Saat ini sarana penyedia informasi fasilitas umum Kota Batam masih secara manual yang 
pada umumnya statis tidak interaktif. Masyarakat Kota Batam baik itu masyarakat umum atau 
masyarakat industri perlu untuk mengetahui informasi fasilitas umum yang ada.  
 
Masyarakat yang ingin mencari informasi tentang fasilitas umum melakukan pencarian dari buku 
atau majalah dengan data yang tidak akurat, hal itu akan menyebabkan kesalahan dalam pencarian. 
Sarana penyedia informasi hanya bisa menyediakan informasi yang tidak terkini. 
 
Hal tersebut menyebabkan keharusan adanya sistem informasi yang dinamis, interaktif dan terkini, 
yang membantu masyarakat dalam mencari data tentang fasilitas umum Kota Batam.  

1.2 Tujuan 
Tujuannya adalah mengembangkan Sistem Informasi Geografis untuk Fasilitas Umum (SIGFUM) 
Batam via web, dinamis dan terkini. Sehingga diharapkan: 
1. Masyarakat bisa mengakses informasi tentang fasilitas umum Kota Batam dalam bentuk 

grafik pada web browser. 
2. Bisa melakukan manipulasi data melalui web.Informasi yang didapat lebih terperinci.  

1.3 Batasan Masalah 
SIGFUM akan mengelola informasi sebagai berikut: 
1. Informasi Sarana Infrastruktur yang meliputi ferry terminal/pelabuhan, bandara, ATB, PLN, 

Telkom. 
2. Informasi Kawasan Industri. 
3. Informasi Kawasan Pariwisata. 
4. Informasi Kawasan Perdagangan(Bussiness Area). 
5. Informasi Hotel. 
6. Informasi Bank. 
7. Informasi Rumah Sakit. 
8. Informasi Perguruan Tinggi. 
9. Informasi Jalan Utama. 

10. Informasi Sarana Olahraga. 
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1.4 Ikhtisar Buku 
Adapun ikhtisar buku dari tugas akhir ini terdiri dari 6(enam) BAB, yaitu: 

 
BAB I  : PENDAHULUAN  

Berisi penjelasan tentang latar belakang rancangan aplikasi, tujuan 
pembuatan aplikasi, batasan masalah dan ikhtisar buku. 
  

BAB II : DESKRIPSI UMUM APLIKASI  
Berisi penjelasan tentang deskripsi umum sistem yang memberi 
gambaran tentang aplikasi dan konteksnya, karakteristik pengguna, 
batasan, lingkungan operasi baik lingkungan operasional maupun 
lingkungan pengembangan dan aturan penomoran. 

 
BAB III : ANALISIS 

Berisi tentang deskripsi fungsional yang mencakup konteks diagram dan 
analisis kebutuhan data yang mencakup Entity Relationship (ER) 
diagram.  

 
BAB IV : DESKRIPSI PERANCANGAN  

Berisi deskripsi data meliputi definisi domain/type dan daftar tabel 
aplikasi, dekomposisi fungsional modul, spesifikasi kebergantungan 
antar layar dan struktur menu. 

 
BAB V : IMPLEMENTASI DAN PENGUJIAN 

Berisi tentang spesifikasi kebergantungan antar modul, struktur direktori 
dan deskripsi file, pengujian dan hasilnya. 

 
BAB VI : KESIMPULAN DAN SARAN  

Berisi tentang kesimpulan dari aplikasi dan saran untuk perbaikan serta 
pengembangan terhadap aplikasi yang telah dibuat. 
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BAB 2 DESKRIPSI UMUM APLIKASI 

2.1 Deskripsi Umum Sistem 
SIGFUM adalah sebuah aplikasi yang digunakan untuk mengelola informasi tentang fasilitas 
umum yang ada di Batam. Fasilitas umum yang akan dikelola adalah sarana infrastruktur, kawasan 
industri, kawasan pariwisata, kawasan perdagangan, hotel bank, rumah sakit, perguruan tinggi, 
jalan utama dan sarana olahraga.  
 
Jenis peta yang digunakan adalah peta thematic dimana setiap bentuk informasi nantinya akan 
diberi warna dan simbol tersendiri dan juga akan ditambahkan menu untuk pilihan jenis informasi. 
Informasi yang ditampilkan berbasis images peta Batam. Pengguna memilih informasi fasilitas 
umum yang diinginkan, kemudian aplikasi akan menampilkan informasi berupa grafik sekaligus 
informasi data tentang fasilitas umum sesuai pilihan pengguna. 
 
Secara umum aplikasi bekerja seperti dalam diagram berikut: 

Pen g g u n a
Aplikasi Fasilitas

U mu m B at am b e rb asi s
g ra fi k

P i l ihan infor m as i

    Memberikan informasi

 
Gambar 2.1 Deskripsi Umum Sistem 

Karakteristik Pengguna 
Karakteristik dari pengguna dibagi menjadi 2(dua) bagian seperti dalam tabel berikut: 

 
Tabel 2.1 Karakteristik Pengguna 

 
Kategori Pengguna Tugas Hak Akses 

Administrator Update data Full akses 
User biasa Melihat informasi Akses terbatas 

2.2 Batasan  
Aplikasi ini dapat dijalankan pada browser berbasis grafik. 

2.3 Lingkungan Pengembangan/ Operasional 
Dalam pembuatan aplikasi ini dibutuhkan beberapa hardware, software dan operating system. 
Lingkungan operasional adalah lingkungan tempat aplikasi dijalankan sedangkan lingkungan 
pengembangan adalah lingkungan tempat aplikasi dirancang dan dikembangkan hingga aplikasi ini 
dapat digunakan. 
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2.3.1 Lingkungan Operasional 
Client : 
Pengoperasian aplikasi ini menggunakan beberapa perangkat penunjang, yaitu: 
1. Hardware(PC)  

Prosesor  : Pentium I keatas. 
Memori utama : Minimal 64 MB. 
 

2. Software 
Internet explorer.  
 

Server : 
Pengoperasian aplikasi ini menggunakan beberapa perangkat penunjang, yaitu: 
1. Hardware(PC)  

Prosesor  : Pentium I keatas. 
Memori utama : Minimal 64 MB. 
 

2. Software 
Internet explorer, Arcview 3.0, PhpTriad 2.5.3. 

2.3.2 Lingkungan Pengembangan 
 

Pengembangan aplikasi ini menggunakan beberapa perangkat penunjang, yaitu: 
1. Hardware(PC)  

Prosesor  : Pentium  III dan IV 
Memori utama : Minimal 64 MB 
Printer  : Canon Bubble-Jet BJC-1000 
 

2. Software 
Internet explorer 4.0+, Arcview 3.0, PhpTriad 2.5.3. 

2.4 Aturan Penomoran 
 

Aturan penamaan dan penomoran yang akan digunakan dalam laporan ini akan dijabarkan sebagai 
berikut: 
a. Penamaan bab deskripsinya adalah BAB <angka> <nama bab>. Contohnya BAB 1 

PENDAHULUAN. 
b. Penamaan sub bab deskripsinya adalah <angka>.<angka>. Angka pertama menyatakan 

nomor bab dan diikuti nomor sub bab. Contohnya 2.1 Deskripsi Umum Sistem. 
c. Penamaan sub sub bab menggunakan <angka>.<angka>.<angka>. Angka pertama 

menyatakan nomor bab diikuti nomor sub bab dan nomor sub sub bab. Contohnya 2.4.1 
Lingkungan Operasional. 

d. Penamaan tabel deskripsinya adalah Tabel <angka>.<angka> <nama tabel>. Angka pertama 
menunjukkan bab dan angka kedua menunjukkan nomor tabel. Contohnya Tabel 2.1 
Karakteristik Pengguna. 

e. Penamaan Diagram deskripsinya adalah Diagram <angka>.<angka> <nama gambar>. Angka 
pertama menunjukkan bab dan angka kedua menunjukkan nomor gambar. Contohnya 
Diagram 2.1 Deskripsi Umum Sistem. 

f. Judul lampiran menggunakan huruf besar. 
g. Penamaan sub lampiran deskripsinya adalah <huruf besar>.<angka>. 
h. Penamaan sub sub lampiran deskripsinya adalah <huruf besar>.<angka>.<angka>. 
i. Tabel dan gambar pada lampiran tidak diberi nama. 
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BAB 3 ANALISIS 

3.1 Deskripsi Fungsional 
Dalam deskripsi fungsional akan dibahas proses-proses yang dilakukan oleh aplikasi. Terdiri dari 
Context Diagram, Dfd Level 1 dan Dfd Level 2. Diagram Context merupakan gambaran sistem secara 
umum. Rincian proses akan diterangkan pada Dfd level 1 dan Dfd level 2. 

3.1.1 Context Diagram 

User Biasa

Jenis Fasilitas Umum

Administrator

User ID+Password

Pesan Kesalahan /
Konfirmasi Hasil Pengolahan

0*
Sistem Informasi

Geografis
Fasilitas Umum

Batam

Data rinci, peta, Fasilitas Umum
dalam tabel  

Gambar 3.1 Context Diagram 
 

Deskripsi context diagram pada Sistem Informasi Geografis Fasilitas Umum Batam adalah 
sebagai berikut: 
a. Input 

Jenis fasilitas umum (User biasa), User ID dan Password (Administrator). 
b. Output 

Informasi fasilitas umum (User biasa), Pesan kesalahan atau konfirmasi hasil 
pengolahan (Administrator). 

c. Proses 
Dalam Sistem Informasi Geografis Fasilitas Umum Batam user biasa memasukkan 
jenis fasilitas umum yang akan diproses oleh sistem dan hasilnya berupa informasi 
fasilitas umum. Administrator memasukkan user id dan password ke dalam sistem 
agar dapat melakukan pengolahan fasilitas umum. 

3.1.1.1 DFD Level 1 

User Biasa

Data rinci, peta,
Fasilitas Umum

dalam tabel

1.*
Penyajian
Fasilitas
Umum

User Biasa
Jenis Fasilitas

Umum

saranaolahraga

hotel

jalanutama

kawasanperdagangan

perguruantinggi

kawasanpariwisata

rumahsakit

kawasanindustri

bank

saranainfrastruktur

Administrator

User ID +
Password

hak akses

Pesan Kesalahan

Administrator

3.*
Pengelolaan

Fasilitas
Umum

2.
Login

Konfirmasi hasil
Pengolahan

Jenis fasilitas umum

infrastruktu
r

kawasan industri

pariwisata

perdagangan

hotel

bank

rumah sakit

perguruan tinggi

jalan utama

sarana olahraga

infrastruktu
r

kawasan industri

pariwisata

perdagangan

hotel

bank

rumah sakit

perguruan tinggi

jalan utama

sarana olahraga

 
Gambar 3.2 DFD Level 1 
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Deskripsi proses pada dfd level 1 adalah sebagai berikut: 
1. Proses 1 Penyajian Fasilitas Umum. 

a. Input 
Jenis fasilitas umum (User biasa), data infrastruktur (saranainfrastruktur), 
data kawasanindustri (kawasanindustri), data pariwisata 
(kawasanpariwisata), data perdagangan (kawasanperdagangan), data hotel 
(hotel), data bank (bank), data rumah sakit (rumahsakit), data perguruan 
tinggi (perguruantinggi), data jalan utama (jalanutama), data sarana 
olahraga (saranaolahraga) . 

b. Output 
Data rinci , peta, fasilitas umum dalam tabel 

c. Proses 
Dalam proses penyajian fasilitas umum user biasa memasukkan jenis 
fasilitas umum dan dari tabel memberikan informasi fasilitas umum 
tersebut. Hasil keluaran berupa data rinci, peta, fasilitas umum dalam 
tabel. 
 

2. Proses 2 Login. 
a. Input 

User ID dan Password (Administrator), validasi data login. 
b. Output 

Hak akses dan jenis fasilitas umum (Proses 3), pesan kesalahan  
(Administrator). 

c. Proses 
Dalam proses login administrator memasukkan user ID dan password 
yang akan diperiksa apakah datanya valid atau tidak. Jika data valid maka 
hasil keluaran berupa hak akses pada proses pengolahan fasilitas umum. 
Jika data tidak valid hasil pemrosesan berupa pesan kesalahan. 
 

3. Proses 3 Pengolahan Fasilitas Umum. 
a. Input 

Hak akses (proses 2), jenis fasilitas umum (Administrator), data 
infrastruktur (saranainfrastruktur), data industri (kawasanindustri), data 
pariwisata (kawasanpariwisata), data perdagangan 
(kawasanperdagangan), data hotel (hotel), data bank (bank), data rumah 
sakit (rumahsakit), data perguruan tinggi (perguruantinggi), data jalan 
utama (jalanutama), data sarana olahraga(saranaolahraga) . 

b. Output 
Data infrastruktur (saranainfrastruktur), data kawasanindustri 
(kawasanindustri), data pariwisata (kawasanpariwisata), data perdagangan 
(kawasanperdagangan), data hotel (hotel), data bank (bank), data rumah 
sakit (rumahsakit), data perguruan tinggi (perguruantinggi), data jalan 
utama (jalanutama), data sarana olahraga (saranaolahraga), konfirmasi 
hasil pengolahan (Administrator). 

c. Proses 
Dalam proses pengolahan fasilitas umum setelah administrator 
mempunyai hak akses untuk melakukan pengolahan fasilitas umum dan 
memilih jenis fasilitas umumnya akan dilakukan manipulasi informasi 
fasilitas umum pada table yang sesuai. Hasil keluaran berupa data 
konfirmasi hasil pengolahan fasilitas umum tersebut. 
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3.1.1.2 DFD Level 2  

 Kawasan
Industri

1.5
 Penyajian data
Perdagangan

1.6
 Penyajian data Hotel

1.7
 Penyajian data Bank

1.8
 Penyajian data
Rumah Sakit

1.9
 Penyajian data

Perguruan Tinggi

1.10
 Penyajian data Jalan

Utama

1.11
 Penyajian data

Sarana Olahraga

1.1
Pilihan

Penyajian
Fasilitas
Umum

1.3
 Penyajian data

Kawasan Industri

1.4
 Penyajian data

Pariwisata

1.2
 Penyajian data

Infrastruktur Infrastruktur

 Pariwisata

 Sarana
Olahraga

 Jalan Utama

 Perguruan
Tinggi

 Rumah
Sakit

 Bank

 Hotel

 Perdagangan

User Biasa

Fasilitas
umum dalam
tabel, peta,
data rinci

saranaolahraga

hotel

jalanutama

kawasanperdagangan

perguruantinggi

kawasanpariwisata

rumahsakit

kawasanindustri

bank

saranainfrastruktur

1.12
Penyajian

Data
Fasilitas
Umum

 Penyajian Data Kawasan
Industri

 Penyajian Data
Pariwisata

 Penyajian Data Kawasan
Perdagangan

 Penyajian Data
Hotel

 Penyajian Data
Bank

 Penyajian Data Rumah
Sakit

Penyajian Data Perguruan
Tinggi

 Penyajian Data Jalan
Utama

Penyajian Data Sarana
Olahraga

Penyajian Data
Infrastruktur

User Biasa

Jenis
fasilitas
umum

Skala Gambar, pilihan  = data infrastruktur

Skala Gambar, pilihan  = data kawasan industri

Skala Gambar, pilihan = data pariwisata

Skala Gambar, pilihan = data perdagangan

Skala Gambar, pilihan  = data hotel
Skala Gambar, pilihan  = data bank

Skala Gambar, pilihan  = data rumah sakit

Skala Gambar, pilihan  = data perguruan tinggi

Skala Gambar, pilihan  = data jalan utama

Skala Gambar, pilihan  = data sarana olahraga

 
 

 Gambar 3.3 DFD Level 2 Proses 1 
 
Deskripsi proses pada dfd level 2 Proses 1 adalah sebagai berikut: 
Proses 1.1 Penyajian data fasilitas umum dalam tabel. 
a. Input 

Jenis fasilitas umum (user biasa), informasi fasilitas umum (db_Sigfum). 
b. Output 

Fasilitas umum dalam table (user biasa), objek pilihan (proses1.2). 
c. Proses 

Dalam proses ini user biasa memasukkan jenis fasilitas umum yang akan 
ditampilkan. Informasi fasilitas umum diambil dari db_Sigfum dengan hasil 
keluaran pada user biasa  berupa fasilitas umum yang disajikan dalam bentuk 
table.  

 
Proses 1.2 Penyajian objek dalam peta. 
a. Input 

Jenis fasilitas umum (user biasa), objek pilihan (proses 1.1). 
b. Output 

Objek dalam peta (user biasa), objek pilihan (proses 1.3). 
c. Proses 

Dalam proses ini hasil keluaran berupa tampilan pada peta.  
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Proses 1.3 Penyajian data rinci objek. 
a. Input 
 objek pilihan (proses1.2), informasi fasilitas umum (db_Sigfum). 
b. Output 
 Data rinci objek (user biasa). 
c. Proses 
 Dalam proses ini objek yang ditampilkan pada peta disajikan dalam bentuk 

data rinci. 

Gambar 3.4 DFD Level 2 Proses 3 
 

Deskripsi proses pada dfd level 2 proses 3 adalah sebagai berikut: 
 
Proses 3.1 Pilihan menu pengelolaan fasilitas umum. 
a. Input 

Hak akses, jenis fasilitas umum(Administrator). 
b. Output 

Fasilitas umum dalam tabel(db_Sigfum), objek pilihan(proses 3.2, 3.3, 3.4, 3.5, 
3.6, 3.7, 3.8, 3.9, 3.10, 3.11). 

c. Proses 
Dalam proses ini administrator melakukan Pilihan jenis pengelolaan fasilitas 
umum yaitu Proses 3.2, Proses 3.3, Proses 3.4, Proses 3.5, Proses 3.6, Proses 
3.7, Proses 3.8, Proses 3.9, Proses 3.10 dan Proses 3.11, jika ada pengolahan 
maka data akan tersimpan ke dalam tabel.  

 Kawasan
Industri

3.5
Pengelolaan
Perdagangan

3.6
Pengelolaan Hotel

3.7
Pengelolaan Bank

3.8
Pengelolaan Rumah

Sakit

3.9
Pengelolaan

Perguruan Tinggi

3.10
Pengelolaan Jalan

Utama

3.11
Pengelolaan Sarana

Olahraga

3.1
Pilihan Jenis
Pengelolaan

Fasilitas
Umum

3.3
Pengelolaan

Kawasan Industri

3.4
Pengelolaan
Pariwisata

3.2
Pengelolaan
Infrastruktur  Infrastruktur

 Pariwisata

 Sarana
Olahraga

 Jalan
Utama

 Perguruan
Tinggi

 Rumah
Sakit

 Bank

 Hotel

 Perdagangan

Hak
akses Administrator

Konfirmasi Hasil
Pengelolaan

saranaolahraga

hotel

jalanutama

kawasanperdagang
an

perguruantinggi

kawasanpariwisata

rumahsakit

kawasanindustri

bank

saranainfrastruktur

3.12
Pengelolaan
Konfrimasi

Konfirmasi Pengelolaan Kawasan
Industri

Konfirmasi Pengolaha
Pariwisata

Konfirmasi Pengelolaan Kawasan
Perdagangan

Konfirmasi Pengelolaan
Hotel

Konfirmasi Pengelolaan
Bank

Konfirmasi Pengelolaan
RS

Konfirmasi Pengelolaan Perguruan
Tinggi

Konfirmasi Pengelolaan Jalan
Utama

Konfirmasi Pengelolaan Sarana
Olahraga

Konfirmasi Pengelolaan
Infrastruktur

Administrator

Jenis
fasilitas
 umum

Jenis=Infrastruktur

Jenis=KawasanIndustri

Jenis=Pariwisata

Jenis=Perdagangan

Jenis=Hotel

Jenis=Rumahsakit

Jenis=PerguruanTinggi

Jenis=Bank

Jenis=JalanUtama

Jenis=SaranaOlahraga
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3.1.1.3 DFD Level 3  

3.1.1.3.1 DFD Level 3 Proses 3.2 

Administrator

3.2.1
Penambah

an data
infrastruktu

r

3.2.2
Pengubaha

n data
infrastruktu

r

3.2.3
Penghapus

an data
infrastruktu

r

saranainfrastruktur

3.2.4
Pengelolaa

n
konfirmasi

Administrator

Kriteria infrastruktur
terbaru

Kriteria infrastruktur
terbaru

Kriteria
infrastruktur

terbaru

Infrastruktur terbaru

Infrastruktur terbaru

Masukan
Infrastruktur

terbaru

Konfirmasi
penambahan data

infrastruktur

Konfirmasi
penghapusan data

infrastruktur

Konfirmasi
pengubahan data

infrastruktur

Konfirmasi
pengelolaan
infrastruktur

Data
infrastruktur

 
Gambar 3.5 DFD Level 3 Proses 3.2 

 
Deskripsi proses pada dfd level 3 proses 3.2 adalah sebagai berikut: 
 

  Proses 3.2.1 Penambahan data fasilitas umum. 
a. Input 

Hak akses, jenis fasilitas umum. 
b. Output 

Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 
c. Proses 

Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
Proses 3.2.2 Pengubahan data fasilitas umum. 
a. Input 

Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 
b. Output 

Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 
c. Proses 

Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.2.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.1.1.3.2 DFD Level 3 Proses 3.3 

Administrator

3.3.1
Penambah

an data
kawasan
industri

3.3.2
Pengubaha

n data
kawasan
industri

3.3.3
Penghapus

an data
kawasan
industri

kawasanindustri

3.3.4
Pengelolaa

n
konfirmasi

Administrator

Kriteria kawasan
industri terbaru

Kriteria kawasan
industri terbaru

Kriteria
kawasan
industri
terbaru

Kawasan industri
terbaru

Kawasan industri
terbaru

Masukan
kawasan

industri terbaru

Konfirmasi
penambahan data
kawasan industri

Konfirmasi
penghapusan data
kawasan industri

Konfirmasi
pengubahan data
kawasan industri

Konfirmasi
pengelolaan

kawasan
industri

Data kawasan
industri

 
Gambar 3.6 DFD Level 3 Proses 3.3 

 
Deskripsi proses pada dfd level 3 proses 3.3 adalah sebagai berikut: 

 
Proses 3.3.1 Penambahan data fasilitas umum. 
a. Input 

Hak akses, jenis fasilitas umum. 
b. Output 

Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 
c. Proses 

Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.3.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.3.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.1.1.3.3 DFD Level 3 Proses 3.4 

Administrator

3.4.1
Penamba
han data

pariwisata

3.4.2
Pengubah

an data
pariwisata

3.4.3
Penghapu
san data

pariwisata

kawasanpariwisata

3.4.4
Pengelola

an
konfirmasi

Administrator

Kriteria pariwisata
terbaru

Kriteria pariwisata
terbaru

Kriteria
pariwisata

terbaru

Pariwisata terbaru

Pariwisata terbaru

Masukan
pariwisata

terbaru

Konfirmasi
penambahan data

pariwisata

Konfirmasi
penghapusan data

pariwisata

Konfirmasi
pengubahan data

pariwisata

Konfirmasi
pengelolaan
pariwisata

Data
pariwisata

 
 

Gambar 3.7 DFD Level 3 Proses 3.4 
 

Deskripsi proses pada dfd level 3 proses 3.4 adalah sebagai berikut: 
 
   Proses 3.4.1 Penambahan data fasilitas umum. 

a. Input 
Hak akses, jenis fasilitas umum. 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.4.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.4.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 



  12 

3.1.1.3.4 DFD Level 3 Proses 3.5 
 

Administrator

3.5.1
Penamba
han data
perdagan

gan

3.5.2
Pengubah

an data
perdagan

gan

3.5.3
Penghapu
san data
perdagan

gan

kawasanperdagang
an

3.5.4
Pengelola

an
konfirmasi

Administrator

Kriteria
perdagangan

terbaru

Kriteria
perdagangan

terbaru

Kriteria
perdagangan

terbaru

Perdagangan
terbaru

Perdagangan
terbaru

Masukan
perdagangan

terbaru

Konfirmasi
penambahan data

perdagangan

Konfirmasi
penghapusan data

perdagangan

Konfirmasi
pengubahan data

perdagangan

Konfirmasi
pengelolaan
perdagangan

Data
perdagangan

 
 

Gambar 3.8 DFD Level 3 Proses 3.5 
 

Deskripsi proses pada dfd level 3 proses 3.5 adalah sebagai berikut: 
 
   Proses 3.5.1 Penambahan data fasilitas umum. 

a. Input 
Hak akses, jenis fasilitas umum. 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.5.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.5.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.1.1.3.5 DFD Level 3 Proses 3.6 

Administrator

3.6.1
Penamba
han data
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3.6.2
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penambahan data
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Konfirmasi
penghapusan data
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Konfirmasi
pengubahan data
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Gambar 3.9 DFD Level 3 Proses 3.6 
 

Deskripsi proses pada dfd level 3 proses 3.6 adalah sebagai berikut: 
 
   Proses 3.6.1 Penambahan data fasilitas umum. 

a. Input 
Hak akses, jenis fasilitas umum. 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
Proses 3.6.2 Pengubahan data fasilitas umum. 
a. Input 

Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 
b. Output 

Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 
c. Proses 

Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.6.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.1.1.3.6 DFD Level 3 Proses 3.7 
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Gambar 3.10 DFD Level 3 Proses 3.7 
 

Deskripsi proses pada dfd level 3 proses 3.7 adalah sebagai berikut: 
 
   Proses 3.7.1 Penambahan data fasilitas umum. 

a. Input 
Hak akses, jenis fasilitas umum. 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.7.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.7.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.1.1.3.7 DFD Level 3 Proses 3.8 
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Gambar 3.11 DFD Level 3 Proses 3.8 
    

Deskripsi proses pada dfd level 3 proses 3.8 adalah sebagai berikut: 
 
   Proses 3.8.1 Penambahan data fasilitas umum. 

a. Input 
Hak akses, jenis fasilitas umum. 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.8.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
Proses 3.8.3 Penghapusan data fasilitas umum 
a. Input 

Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 
b. Output 

Konfirmasi hasil pengolahan. 
c. Proses 

Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 

 
 



  16 

3.1.1.3.8 DFD Level 3 Proses 3.9 
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Gambar 3.11 DFD Level 3 Proses 3.9 

  
Deskripsi proses pada dfd level 3 proses 3.9 adalah sebagai berikut: 
 
Proses 3.9.1 Penambahan data fasilitas umum. 
a. Input 

Hak akses, jenis fasilitas umum. 
b. Output 

Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 
c. Proses 

Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.9.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.9.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.1.1.3.9 DFD Level 3 Proses 3.10 
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Gambar 3.12 DFD Level 3 Proses 3.10 
 

Deskripsi proses pada dfd level 3 proses 3.10 adalah sebagai berikut: 
 
   Proses 3.10.1 Penambahan data fasilitas umum. 

a. Input 
Hak akses, jenis fasilitas umum. 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.10.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.10.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.1.1.3.10 DFD Level 3 Proses 3.11 
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Gambar 3.13 DFD Level 3 Proses 3.11 
 

Deskripsi proses pada dfd level 3 proses 3.11 adalah sebagai berikut: 
 
   Proses 3.11.1 Penambahan data fasilitas umum. 

a. Input 
Hak akses, jenis fasilitas umum. 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penambahan data ke dalam db_Sigfum. Hasil 
keluaran ke administrator berupa konfirmasi penambahan data. 

 
   Proses 3.11.2 Pengubahan data fasilitas umum. 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Fasilitas umum(db_Sigfum), Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan pengubahan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi pengubahan 
data. 

 
   Proses 3.11.3 Penghapusan data fasilitas umum 

a. Input 
Hak akses dan jenis fasilitas umum, fasilitas umum(db_Sigfum). 

b. Output 
Konfirmasi hasil pengolahan. 

c. Proses 
Dalam proses ini dilakukan penghapusan data fasilitas umum dalam 
db_Sigfum. Hasil keluaran ke administrator berupa konfirmasi penghapusan 
data. 
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3.2 Analisis Kebutuhan Data 

3.2.1 E-R Diagram   
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Gambar 3.14 ER-Diagram 

 
Entity  : saranainfrastruktur 
Atribut  : id_saranainfrastruktur, Nama, Alamat, Jenis, No_telp, No_fax, Shape 
Primary key : id_saranainfrastruktur 
 
Entity  : kawasan industri 
Atribut  : id_kawasanindustri, Nama, Alamat, No_telp, Shape 
Primary key : id_kawasanindustri 
 
Entity  : kawasanpariwisata 
Atribut  : id_kawasanpariwisata, Nama, Alamat, No_telp, Shape 
Primary key : id_kawasanpariwisata 
 
Entity  : kawasanperdagangan 
Atribut  : id_kawasanperdagangan, Nama, Alamat, Shape 
Primary key : id_kawasanperdagangan 
 
Entity  : hotel 
Atribut  : id_hotel, Nama, Alamat, Jenis, No_telp, No_fax, Shape 
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Primary key : id_hotel 
 
Entity  : bank 
Atribut  : id_bank, Nama, Alamat,No_telp, Shape 
Primary key : id_bank 
 
Entity  : rumahsakit 
Atribut  : id_rumahsakit, Nama, Alamat, No_telp, Shape 
Primary key : id_rumahsakit 
 
Entity  : perguruantinggi 
Atribut  : id_perguruantiggi, Nama, Alamat, No_telp, Shape 
Primary key : id_perguruantinggi 
 
Entity  : jalan utama 
Atribut  : id_jalanutama, Nama, Lokasi, Shape 
Primary key : id_jalanutama 
 
Entity  : saranaolahraga 
Atribut  : id_saranaolahraga, Nama, Alamat, Jenis, No_telp, Shape 
Primary key : id_saranaolahraga 
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BAB 4 DESKRIPSI PERANCANGAN 

4.1 Deskripsi Data 
Tabel 4.1 Daftar Tabel Deskripsi Data SIGFUM 

 

No Nama table Deskripsi Isi Jenis Volume Laju Primary 
key 

1 saranainfrastruk
tur 

Data sarana 
infrastruktur Transaksi ± 10 record ± 1 record per 

tahun 
Id_saranainf
rastruktur 

2 kawasanindustri Data kawasan 
industri Transaksi ± 12 record ± 1 record per 

tahun 
Id_kawasani
ndustri 

3 kawasanpariwis
ata 

Data kawasan 
pariwisata Transaksi ± 6 record ± 1 record per 

tahun 
Id_kawasan
pariwisata 

4 kawasanperdaga
ngan 

Data kawasan 
perdagangan Transaksi ± 10 record ± 1 record per 

tahun 
Id_kawasan
perdagangan 

5 hotel Data hotel Transaksi ± 10 record ± 1 record per 
tahun Id_hotel 

6 bank Data bank Transaksi ± 10 record ± 1 record per 
tahun Id_bank 

7 rumahsakit Data rumah sakit Transaksi ± 4 record ± 1 record per 
tahun 

Id_rumahsa
kit 

8 perguruantinggi Data perguruan 
tinggi Transaksi ± 8 record ± 1 record per 

2 tahun 
Id_pergurua
ntinggi 

9 jalanutama Data jalan utama Transaksi ± 15 record ± 1 record per 
2 tahun 

Id_jalanuta
ma 

10 olahraga Data sarana 
olahraga Transaksi ± 11 record ± 1 record per 

tahun 
Id_saranaola
hraga 

4.1.1 Definisi Domain/Type  
Tidak ada. 

4.1.2 Daftar Tabel Aplikasi  
Di bawah ini akan ditampilkan daftar tabel basisdata yang ada dalam Sistem Informasi 
Geografis Fasilitas Umum Batam. 

 
Tabel 4.2 Daftar Tabel Basisdata SIGFUM 

 

No Nama Tabel Primary key Data Store E/R Deskripsi isi 

1 saranainfrast
ruktur 

Id_saranainfra
struktur 

kawasaninfrastr
uktur  

s a r a n a
in f r a s t r u k tu r

I d _ s a r a n
a in f r a s t r u

k t u r

N a m a
A la m a t

J e n is

N o _ te lp

N o _ fa x  

Data sarana 
infrastruktur 

2 kawasanindu
stri 

Id_kawasanin
dustri 

kawasanindustri
 

 

kawasan
industri

Id_kawas
anindustri

Nama Alamat

No_telp

No_fax

Shape  

Data kawasan 
industri 
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No Nama Tabel Primary key Data Store E/R Deskripsi isi 

3 kawasanpari
wisata 

Id_kawasanpa
riwisata 

kawasanpariwisata
 

k a w a s a n
p a r iw is a ta

Id _ p a r iw i
s a ta

N a m a

S h a p e

N o _ te lpN o _ fa x

 

Data kawasan 
pariwisata 

4 kawasanperd
agangan 

Id_kawasanpe
rdagangan 

kawasanperdagang
an

 

kawasan
perdagangan

Alamat Nama
Id_perda
gangan

Shape

 

Data kawasan 
perdagangan 

5 Hotel Id_hotel hotel

 
ho te l

Id _h o te l
N a m a

A lam a t

Jen is

N o _te lpN o_ fa xS ha pe  

Data hotel 

6 Bank Id_bank bank  b a n k

Id _ b a n k
N a m aA la m a t

N o _ te lp

S h a p e  

Data bank 

7 RumahSakit Id_rumahsakit rumahsakit  
r u m a h s a k it

Id _ ru m a h
s a k i t

N a m a

A la m a t

N o _ t e lp S h a p e

 

Data rumah 
sakit 

8 PerguruanTi
nggi 

Id_perguruanti
nggi perguruantinggi  

p e r g u r u a n
t in g g i

I d _ p e r g u r u
a n t i n g g i

N a m a

A la m a t

N o _ te lp
S h a p e

 

Data perguruan 
tinggi 

9 JalanUtama Id_jalanutama jalanutama  
ja la n u ta m a

Id _ ja la n
u ta m a

N a m a L o k a s i

S h a p e

 

Data jalan 
utama 

10 Olahraga Id_saranaolahr
aga saranaolahraga  

s a r a n a
o l a h r a g a

I d _ s a r a n a
o l a h r a g a

N a m a

A l a m a t

N o _ t e l pJ e n i s

S h a p e

 

Data sarana 
olahraga 

4.2 Dekomposisi Fungsional Modul 
 

Tabel 4.3 Input-Proses-Output SIGFUM 
 

No No. 
Fungsi Fungsi/Proses Tabel Input Data Input Tabel  

Output Data Output 

1 F1 
Pilihan 
Penyajian 
fasilitas umum 

- Jenis fasilitas 
umum - - 

2 F2 Penyajian data 
infrastruktur 

saranainfrast
ruktur 

Pilihan berupa 
data infrastruktur 
dan skala gambar 

- Penyajian data 
infrastruktur 

3 F3 
Penyajian data 
kawasan 
industri 

Industri 

Pilihan berupa 
data kawasan 
industri dan skala 
gambar 

- Penyajian data 
kawasan industri 
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No No. 
Fungsi Fungsi/Proses Tabel Input Data Input Tabel  

Output Data Output 

4 F4 Penyajian data 
pariwisata 

kawasanpari
wisata 

Pilihan berupa 
data pariwisata 
dan skala gambar 

- 
Penyajian data 
kawasan 
pariwisata 

5 F5 Penyajian data 
perdagangan 

kawasanperd
agangan 

Pilihan berupa 
data perdagangan 
dan skala gambar 

- Penyajian data 
perdagangan 

6 F6 Penyajian data 
hotel Hotel 

Pilihan berupa 
data hotel dan 
skala gambar 

- Penyajian data 
hotel 

7 F7 Penyajian data 
bank Bank 

Pilihan berupa 
data bank dan 
skala gambar 

- Penyajian data 
bank 

8 F8 Penyajian data 
rumah sakit RumahSakit 

Pilihan berupa 
data rumah sakit 
dan skala gambar 

- Penyajian data 
rumah sakit 

9 F9 
Penyajian data 
perguruan 
tinggi 

PerguruanTi
nggi 

Pilihan berupa 
data perguruan 
tinggi dan skala 
gambar 

- Penyajian data 
perguruan tinggi 

10 F10 Penyajian data 
jalan utama JalanUtama 

Pilihan berupa 
data jalan utama 
dan skala gambar 

- Penyajian data 
jalan utama 

11 F11 
Penyajian data 
sarana 
olahraga 

Olahraga 

Pilihan berupa 
data sarana 
olahraga dan skala 
gambar 

- Penyajian data 
sarana olahraga 

12 F12 Login Login - - Hak akses,pesan 
kesalahan 

13 F13 
Pilihan jenis 
pengelolaan 
fasilitas umum 

- Jenis fasilitas 
umum - - 

14 F14 
Penambahan 
data 
infrastruktur 

- 

Id_saranainfrastru
ktur, Nama, 
Alamat, Jenis, 
No_telp, No_fax, 
Shape 

saranain
frastrukt
ur 

Konfirmasi 
pengelolaan 
infrastruktur, 
Id_saranainfrastru
ktur,Nama,Alamat
,Jenis,No_telp,No
_fax,Shape 

15 F15 
Pengubahan 
data 
infrastruktur 

saranainfrast
ruktur 

Id_saranainfrastru
ktur, Nama, 
Alamat, Jenis, 
No_telp, No_fax, 
Shape 

saranain
frastrukt
ur 

Konfirmasi 
pengelolaan 
infrastruktur, 
Id_saranainfrastru
ktur,Nama,Alamat
,Jenis,No_telp,No
_fax,Shape 

16 F16 
Penghapusan 
data 
infrastruktur 

saranainfrast
ruktur 

Id_saranainfrastru
ktur, 
Nama,Alamat,Jeni
s,No_telp,No_fax,
Shape 

- 

Konfirmasi 
pengelolaan 
infrastruktur, 
Id_saranainfrastru
ktur,Nama,Alamat
,Jenis,No_telp,No
_fax,Shape 

17 F17 
Penambahan 
data kawasan 
industri 

- 

Id_kawasanindustr
i,Nama,Alamat, 
No_telp, 
No_fax,Shape 

Kawasa
nIndustri 

Konfirmasi 
pengelolaan 
kawasan industri, 
Id_kawasanindustr
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No No. 
Fungsi Fungsi/Proses Tabel Input Data Input Tabel  

Output Data Output 

i,Nama,Alamat, 
No_telp, 
No_fax,Shape 

18 F18 
Pengubahan 
data kawasan 
industri 

KawasanInd
ustri 

Id_kawasanindustr
i,Nama,Alamat, 
No_telp, 
No_fax,Shape 

KawasaI
ndustri 

Konfirmasi 
pengelolaan 
kawasan industri, 
Id_kawasanindustr
i,Nama,Alamat, 
No_telp, 
No_fax,Shape 

19 F19 
Penghapusan 
data kawasan 
industri 

KawasanInd
ustri 

Id_kawasanindustr
i,Nama,Alamat, 
No_telp, 
No_fax,Shape 

- 

Konfirmasi 
pengelolaan 

kawasan industri, 
Id_kawasanindustr

i,Nama,Alamat, 
No_telp, 

No_fax,Shape 

20 F20 
Penambahan 
data 
pariwisata 

- 
Id_kawasanpariwi
sata,Nama,Alamat, 
No_telp,Shape 

kawasan
pariwisa
ta 

Konfirmasi 
pengelolaan 
pariwisata, 
Id_kawasanpariwi
sata,Nama,Alamat, 
No_telp,Shape 

21 F21 
Pengubahan 
data 
pariwisata 

kawasanpari
wisata 

Id_kawasanpariwi
sata,Nama,Alamat, 
No_telp,Shape 

kawasan
pariwisa
ta 

Konfirmasi 
pengelolaan 
pariwisata, 
Id_kawasanpariwi
sata,Nama,Alamat, 
No_telp,Shape 

22 F22 
Penghapusan 
data 
pariwisata 

kawasanpari
wisata 

Id_kawasanpariwi
sata,Nama,Alamat, 
No_telp,Shape 

- 

Konfirmasi 
pengelolaan 
pariwisata, 
Id_kawasanpariwi
sata,Nama,Alamat, 
No_telp,Shape 

23 F23 
Penambahan 
data 
perdagangan 

- 
Id_kawasanperdag
angan,Nama,Alam
at,Shape 

kawasan
perdaga

ngan 

Konfirmasi 
pengelolaan 
kawasan 
perdagangan, 
Id_kawasanperdag
angan,Nama,Alam
at,Shape 

24 F24 
Pengubahan 
data 
perdagangan 

kawasanperd
agangan 

Id_kawasanperdag
angan,Nama,Alam
at,Shape 

kawasan
perdaga

ngan 

Konfirmasi 
pengelolaan 
kawasan 
perdagangan, 
Id_kawasanperdag
angan,Nama,Alam
at,Shape 

25 F25 
Penghapusan 
data 
perdagangan 

kawasanperd
agangan 

Id_kawasanperdag
angan,Nama,Alam
at,Shape 

- 

Konfirmasi 
pengelolaan 
kawasan 
perdagangan, 
Id_kawasanperdag
angan,Nama,Alam
at,Shape 

26 F26 Penambahan - Id_hotel,Nama,Ala Hotel Konfirmasi 
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No No. 
Fungsi Fungsi/Proses Tabel Input Data Input Tabel  

Output Data Output 

data hotel mat,Jenis,No_telp,
No_fax,Shape 

pengelolaan 
hotel,Id_hotel,Na
ma,Alamat,Jenis,N
o_telp,No_fax,Sha
pe 

27 F27 Pengubahan 
data hotel Hotel 

Id_hotel,Nama,Ala
mat,Jenis,No_telp,
No_fax,Shape 

Hotel 

Konfirmasi 
pengelolaan 
hotel,Id_hotel,Na
ma,Alamat,Jenis,N
o_telp,No_fax,Sha
pe 

28 F28 Penghapusan 
data hotel Hotel 

Id_hotel,Nama,Ala
mat,Jenis,No_telp,
No_fax,Shape 

- 

Konfirmasi 
pengelolaan 
hotel,Id_hotel,Na
ma,Alamat,Jenis,N
o_telp,No_fax,Sha
pe 

29 F29 Penambahan 
data bank - Id_bank,Nama,Ala

mat,No_telp,Shape Bank 

Konfirmasi 
pengelolaan bank, 
Id_bank,Nama,Ala
mat,No_telp,Shape 

30 F30 Pengubahan 
data bank Bank Id_bank,Nama,Ala

mat,No_telp,Shape Bank 

Konfirmasi 
pengelolaan bank, 
Id_bank,Nama,Ala
mat,No_telp,Shape 

31 F31 Penghapusan 
data bank Bank Id_bank,Nama,Ala

mat,No_telp,Shape - 

Konfirmasi 
pengelolaan bank, 
Id_bank,Nama,Ala
mat,No_telp,Shape 

32 F32 
Penambahan 
data rumah 
sakit 

- 
Id_rumahsakit,Na
ma,Alamat,No_tel
p,Shape 

RumahS
akit 

Konfirmasi 
pengelolaan 
rumahsakit,Id_rum
ahsakit,Nama,Ala
mat,No_tel,Shape 
p 

33 F33 
Pengubahan 
data rumah 
sakit 

RumahSakit 
Id_rumahsakit,Na
ma,Alamat,No_tel
p,Shape 

RumahS
akit 

Konfirmasi 
pengelolaan 
rumahsakit,Id_rum
ahsakit,Nama,Ala
mat,No_telp,Shape 

34 F34 
Penghapusan 
data rumah 
sakit 

RumahSakit 
Id_rumahsakit,Na
ma,Alamat,No_tel
p,Shape 

- 

Konfirmasi 
pengelolaan  
rumahsakit,Id_rum
ahsakit,Nama,Ala
mat,No_telp,Shape 

35 F35 
Penambahan 
data perguruan 
tinggi 

- 
Id_perguruantingg
i,Nama,Alamat,No
_telp,Shape 

Pergurua
nTinggi 

Konfirmasi 
pengelolaan 
perguruan 
tinggi,Id_pergurua
ntinggi,Nama,Ala
mat,No_telp,Shape 

36 F36 
Pengubahan 
data perguruan 
tinggi 

PerguruanTi
nggi 

Id_perguruantingg
i,Nama,Alamat,No
_telp,Shape 

Pergurua
nTinggi 

Konfirmasi 
pengelolaan 
perguruan 
tinggi,Id_pergurua
ntinggi,Nama,Ala
mat,No_telp,Shape 
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No No. 
Fungsi Fungsi/Proses Tabel Input Data Input Tabel  

Output Data Output 

37 F37 
Penghapusan 
data perguruan 
tinggi 

PerguruanTi
nggi 

Id_perguruantingg
i,Nama,Alamat,No
_telp,Shape 

- 

Konfirmasi 
pengelolaan 
perguruan 
tinggi,Id_pergurua
ntinggi,Nama,Ala
mat,No_telp,Shape 

38 F38 
Penambahan 
data jalan 
utama 

- Id_jalanutama,Na
ma,Lokasi,Shape 

JalanUta
ma 

Konfirmasi 
pengelolaan jalan 
utama,Id_jalanuta
ma,Nama,Lokasi,S
hape 

39 F39 
Pengubahan 
data jalan 
utama 

JalanUtama Id_jalanutama,Na
ma,Lokasi,Shape 

JalanUta
ma 

Konfirmasi 
pengelolaan jalan 
utama,Id_jalanuta
ma,Nama,Lokasi,S
hape 

40 F40 
Penghapusan 
data jalan 
utama 

JalanUtama Id_jalanutama,Na
ma,Lokasi,Shape - 

Konfirmasi 
pengelolaan jalan 
utama,Id_jalanuta
ma,Nama,Lokasi,S
hape 

41 F41 
Penambahan 
data sarana 
olahraga 

- 
Id_saranaolahraga,
Nama,Alamat,Jeni
s,No_telp,Shape 

Olahrag
a 

Konfirmasi 
pengelolaan sarana 
olahraga, 
Id_saranaolahraga,
Nama,Alamat,Jeni
s,No_telp,Shape 

42 F42 
Pengubahan 
data sarana 
olahraga 

Olahraga 
Id_saranaolahraga,
Nama,Alamat,Jeni
s,No_telp,Shape 

Olahrag
a 

Konfirmasi 
pengelolaan sarana 
olahraga, 
Id_saranaolahraga,
Nama,Alamat,Jeni
s,No_telp,Shape 

43 F43 
Penghapusan 
data sarana 
olahraga 

Olahraga 
Id_saranaolahraga,
Nama,Alamat,Jeni
s,No_telp,Shape 

- 

Konfirmasi 
pengelolaan sarana 
olahraga, 
Id_saranaolahraga,
Nama,Alamat,Jeni
s,No_telp,Shape 
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4.3 Spesifikasi Kebergantungan Antar Layar 
 

Kebergantungan antar layar pada Sistem Informasi Geografis Fasilitas Umum Batam digambarkan 
sebagai berikut : 

 

Penyajian Data
Sarana

Infasturtur

Penyajian Data
Rumah Sakit

Penyajian Data
Kawasan
Industri

Penyajian Data
Perguruan

Tinggi

Penyajian Data
Hotel

Penyajian Data
Sarana

Olahraga

Penyajian Data
Kawasan

Perdagangan

Penyajian Data
Jalan Utama

Penyajian Data
Kawasan

Pariwisata

Penyajian Data
Bank

Pilihan Jenis Fasilitas
Umum

Pengelolaan
Sarana

Infasturtur

Pengelolaan
Rumah Sakit

Pengelolaan
Kawasan
Industri

Pengelolaan
Perguruan

Tinggi

Pengelolaan
Hotel

Pengelolaan
Sarana

Olahraga

Pengelolaan
Kawasan

Perdagangan

Pengelolaan
Jalan Utama

Pengelolaan
Kawasan

Pariwisata

Pengelolaan
Bank

Penamb
ahan
Data

Penguba
han Data

Penghap
usan
Data

Penamb
ahan
Data

Penguba
han Data

Penghap
usan
Data

Penamb
ahan
Data

Penguba
han Data

Penghap
usan
Data

Penamb
ahan
Data

Pengubah
an Data

Penghapu
san Data

Penamb
ahan
Data

Pengubah
an Data

Penghapu
san Data

Penamb
ahan
Data

Pengubah
an Data

Penghapu
san Data

Penamb
ahan
Data

Pengubah
an Data

Penghapu
san Data

Penamb
ahan
Data

Pengubah
an Data

Penghapu
san Data

Penamb
ahan
Data

Pengubah
an Data

Penghapu
san Data

Penamb
ahan
Data

Pengubah
an Data

Penghapu
san Data

Login Administrator

Form Index

 

4.4 Struktur Menu 
Sistem Informasi Geografis Fasilitas Umum Batam 

----- Menu Pilihan Jenis Fasilitas Umum   
                          ---- Penyajian data Infrastruktur 
                                 ----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut infrastruktur 
----home 
                                                      

                          ---- Penyajian data Kawasan Industri 
                                        ----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut kawasan industri 
----home 

                                                                  
                          ---- Penyajian data Pariwisata 

----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut pariwisata 
----home 

                                                                
                                               
                          ---- Penyajian data Perdagangan 
      ----Data atribut per objek 
                                 ----zoom in 
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----Zoom out 
----pan 
----filter 
----Data Atribut Perdagangan 
----home                                               

                                               
                          ---- Penyajian data Bank 

----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut bank 
----home                                              

                                               
                          ---- Penyajian data Hotel 

----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut hotel 
----home                                               

                                               
                          ---- Penyajian data Rumah Sakit 

----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut RS 
----home                                               

                                               
                          ---- Penyajian data Perguruan Tinggi 

----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut Perguruan Tinggi 
----home                                               

                                               
                          ---- Penyajian data Jalan Utama 

----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut Jalan Utam 
----home                                               

 
                          ---- Penyajian data Sarana Olahraga                                  

----Data atribut per objek 
                                 ----zoom in 

----Zoom out 
----pan 
----filter 
----Data Atribut Sarana Olahraga 
----home 
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BAB 5 IMPLEMENTASI DAN PENGUJIAN 

5.1 Batasan Implementasi 
1. Aplikasi dikembangkan dengan menggunakan tools OpenSVGMapServer 1.01(lihat lampiran 

G). 
2. Tabel  yang ada di dalam deskripsi perancangan adalah tabel yang terdapat pada ArcView (lihat 

lampiran F). Sedangkan tabel yang digunakan untuk aplikasi SIGFUM adalah hasil export data 
ArcView ke dalam MySQL (lihat lampiran G). 

3. Manipulasi data fasilitas umum dilakukan oleh ArcView. 

5.2 Spesifikasi Kebergantungan Antar Modul  
Tidak ada. 

5.3 Struktur Direktori dan Deskripsi File 
 

Tabel 5.1 Daftar Direktori dan File SIFGUM 
 

Nama 
Direktori Nama File Nama 

Modul Nama Fungsi Keterangan 

Penambahan data 
infrastruktur 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
infrastruktur 

1 file mempunyai 
banyak fungsi 

saranainfrastruktur.shp 

saranainfrastruktur.shx 

saranainfrastruktur.dbf 

 

Halaman 
sarana 
infrastruktur 

Penghapusan data 
infrastruktur 

1 file mempunyai 
banyak fungsi 

Penambahan data 
industri 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
industri 

1 file mempunyai 
banyak fungsi 

kawasanindustri.shp 

kawasanindustri.shx 

kawasanindustri.dbf 

Halaman 
kawasan 
industri 

Penghapusan data 
industri 

1 file mempunyai 
banyak fungsi 

Penambahan data 
pariwisata 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
pariwisata 

1 file mempunyai 
banyak fungsi 

kawasanpariwisata.shp 

kawasanpariwisata.shx 

kawasanpariwisata.dbf 

Halaman 
kawasan 
pariwisata 

Penghapusan data 
pariwisata 

1 file mempunyai 
banyak fungsi 

Penambahan data 
perdagangan 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
perdagangan 

1 file mempunyai 
banyak fungsi 

kawasanperdagangan.shp 

kawasanperdagangan.shx 

kawasanperdagangan.dbf 

Halaman 
kawasan 
perdagangan 

Penghapusan data 
perdagangan 

1 file mempunyai 
banyak fungsi 

Project_shp 

 

hotel.shp Halaman 
hotel 

Penambahan data 
hotel 

1 file mempunyai 
banyak fungsi 
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Nama 
Direktori Nama File Nama 

Modul Nama Fungsi Keterangan 

Pengubahan data 
hotel 

1 file mempunyai 
banyak fungsi 

hotel.shx 

hotel.pdf 

 

Penghapusan data 
hotel 

1 file mempunyai 
banyak fungsi 

Penambahan data 
bank 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
bank 

1 file mempunyai 
banyak fungsi 

bank.shp 

bank.shx 

bank.pdf 

Halaman 
bank 

Penghapusan data 
bank 

1 file mempunyai 
banyak fungsi 

Penambahan data 
rumahsakit 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
rumahsakit 

1 file mempunyai 
banyak fungsi 

rumahsakit.shp 

rumahsakit.shx 

rumahsakit.pdf 

Halaman 
rumah sakit 

Penghapusan data 
rumahsakit 

1 file mempunyai 
banyak fungsi 

Penambahan data 
pergurantinggi 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
pergurantinggi 

1 file mempunyai 
banyak fungsi 

perguruantinggi.shp 

perguruantinggi.shx 

perguruantinggi.pdf 

Halaman 
perguruan 
tinggi 

Penghapusan data 
pergurantinggi 

1 file mempunyai 
banyak fungsi 

Penambahan data 
jalanutama 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
jalanutama 

1 file mempunyai 
banyak fungsi 

jalanutama.shp 

jalanutama.shx 

jalanutama.pdf 

Halaman 
jalan utama 

Penghapusan data 
jalanutama 

1 file mempunyai 
banyak fungsi 

Penambahan data 
saranaolahraga 

1 file mempunyai 
banyak fungsi 

Pengubahan data 
saranaolahraga 

1 file mempunyai 
banyak fungsi 

 

saranaolahraga.shp 

saranaolahraga.shx 

saranaolahraga.pdf 

Halaman 
sarana 
olahraga 

Penghapusan data 
saranaolahraga 

1 file mempunyai 
banyak fungsi 

saranainfrastruktur.sql 

connect. php 

saranainfrastruktur.bmp 

Halaman 
sarana 
infrastruktur 

Informasi data 
infrastruktur 

1 modul menjadi 
banyak file toMySQL 

kawasanindustri.sql 

connect php 

kawasanindustri.bmp 

Halaman 
kawasan 
industri 

Informasi data 
industri 

1 modul menjadi 
banyak file 
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Nama 
Direktori Nama File Nama 

Modul Nama Fungsi Keterangan 

kawasanpariwisata.sql 

connect.php 

kawasanpariwisata.bmp 

Halaman 
kawasan 
pariwisata 

Informasi data 
pariwisata 

1 modul menjadi 
banyak file 

kawasanperdagangan.sql 

connect.php 

kawasanperdagangan.bmp 

Halaman 
kawasan 
perdagangan 

Informasi data 
perdagangan 

1 modul menjadi 
banyak file 

hotel.sql 

connect.php 

hotel.bmp 

Halaman 
hotel Informasi data hotel 1 modul menjadi 

banyak file 

bank.sql 

connect.php 

bank.bmp 

Halaman 
bank Informasi data bank 1 modul menjadi 

banyak file 

rumahsakit.sql 

connect.php 

rumahsakit.bmp 

Halaman 
rumah sakit 

Informasi data 
rumahsakit 

1 modul menjadi 
banyak file 

perguruantinggi.sql 

connect.php 

perguruantinggi.bmp 

Halaman 
perguruan 
tinggi 

Informasi data 
pergurantinggi 

1 modul menjadi 
banyak file 

jalanutama.sql 

connect.php 

jalanutama.bmp 

Halaman 
jalan utama 

Informasi data 
jalanutama 

1 modul menjadi 
banyak file 

 

saranaolahraga.sql 

connect.php 

saranaolahraga.bmp 

Halaman 
sarana 
olahraga 

Informasi data 
saranaolahraga 

1 modul menjadi 
banyak file 

Project_apr projectbatam.apr - - 

Tidak ada nama 
modul dan nama 
fungsi sebab isinya 
hanya data dan 
indeks 

5.4 Pengujian dan Hasilnya 
 

Pengujian aplikasi telah dilaksanakan, dan hasil dari pengujian tersebut dilampirkan pada Lampiran D 
dalam laporan ini. 
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BAB 6 KESIMPULAN DAN SARAN 

6.1 Kesimpulan 
Kesimpulan yang dapat diambil dari aplikasi ini adalah: 
1. User bisa mendapatkan informasi tentang fasilitas umum yang ada di Batam dalam bentuk grafik 

pada web browser dan informasi yang didapat lebih terperinci. 
2. Aplikasi ini menyajikan informasi tentang fasilitas umum yang ada di Batam secara uptodate. 
3. Dapat melakukan fungsi identify feature, zoom in, zoom out, pan, filter, open attribut table, 

home.  
4. Untuk fungsi zoom in jika dijalankan pertama kali skala tidak berubah, namun untuk selanjutnya 

skala dapat berubah. 
5. Untuk fungsi zoom out jika fungsi ini dijalankan setelah zoom in maka yang terjadi skala mejadi 

kecil seharusnya bertambah besar dari skala sebelumnya. 

6.2 Saran 
Saran perbaikan untuk aplikasi ini adalah:  
1. Menggunakan legend standard pada pemetaan. 
2. Fungsi Zoom (zoom in dan zoom out) bisa berfungsi dengan baik. 
3. Masukan jarak antara satu objek dengan objek yang lain. 
4. Saat melakukan fungsi filter bisa langsung zoom out. 
5. Dapat melakukan manipulasi data (add, update dan delete) melalui web, karena untuk aplikasi 

ini manipulasi data masih dilakukan dengan ArcView. 
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LAMPIRAN A PERANCANGAN RINCI TABEL 

A.1 Spesifikasi Tabel Sarana Infrastruktur 
Nama tabel  : saranainfrastruktur 
Deskripsi isi : Berisi tentang sarana infrastruktur  
Primary Key : Id_saranainfrastruktur 
Volume : +  10 record  
Perkiraan Laju : +  1 record per tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_saranainfrastruktur Identitas infrastruktur Varchar Tidak  
Nama Nama sarana infrastruktur Varchar   
Alamat Alamat infrastruktur Varchar   
jenis Jenis infrastruktur Varchar   
No_telp No telp yang dapat dihubungi Varchar   
No_fax No fax yang dapat dihubungi Varchar   

A.2 Spesifikasi Tabel Kawasan Industri 
Nama tabel  : kawasanindustri 
Deskripsi isi : Berisi tentang kawasan industri 
Primary Key : Id_kawasanindustri 
Volume : +  12 record   
Perkiraan Laju : +  1 record per tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_kawasanindustri Identitas kawasan industri Varchar Tidak  
Nama Nama kawasan industri Varchar   
Alamat Alamat kawasan industri Varchar   
No_telp No telp yang dapat dihubungi Varchar   
No_fax No fax yang dapat dihubungi Varchar   

A.3 Spesifikasi Tabel Kawasan Pariwisata 
Nama tabel  : kawasanpariwisata 
Deskripsi isi : Berisi tentang kawasan pariwisata 
Primary Key : Id_kawasanpariwisata 
Volume : +  6 record  
Perkiraan Laju : +  1 record per tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_kawasanpariwisata Identitas kawasan pariwisata Varchar Tidak  
Nama Nama kawasan pariwisata Varchar   
Alamat Alamat kawasan pariwisata Varchar   
No_telp No yang dapat dihubungi Varchar   
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A.4 Spesifikasi Tabel Kawasan Perdagangan 
Nama tabel  : kawasanperdagangan 
Deskripsi isi : Berisi tentang kawasan perdagangan 
Primary Key : Id_kawasanperdagangan 
Volume : +  10 record  
Perkiraan Laju : +  1 record per tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_kawasanperdagangan Identitas kawasan perdagangan Varchar Tidak  
Nama Nama kawasan perdagangan Varchar   
Alamat Alamat kawasan perdagangan Varchar   

A.5 Spesifikasi Tabel Hotel 
Nama tabel  : hotel 
Deskripsi isi : Berisi tentang hotel yang ada 
Primary Key : Id_hotel 
Volume : +  10 record  
Perkiraan Laju : +  1 record per tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_hotel Identitas hotel Varchar Tidak  
Nama Nama hotel Varchar   
Alamat Alamat hotel Varchar   
Jenis Jenis hotel Varchar   
No_telp Nomor telp yang dapat dihubungi Varchar   
No_fax Nomor fax yang dapat dihubungi Varchar   

A.6 Spesifikasi Tabel Bank 
Nama tabel  : bank 
Deskripsi isi : Berisi informasi bank yang ada 
Primary Key : Id_bank 
Volume : +  10 record 
Perkiraan Laju : +  1 record per tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_bank Identitas bank Varchar Tidak  
Nama Nama bank Varchar   
Alamat Alamat bank Varchar   
No_telp No telp yang dapat dihubungi Varchar   

A.7 Spesifikasi Tabel Rumah Sakit 
Nama tabel  : rumahsakit 
Deskripsi isi : Berisi tentang rumah sakit yang ada 
Primary Key : Id_rumahsakit 
Volume : +  4 record 
Perkiraan Laju : +  1 record per tahun 
Daftar Field 
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Nama  field Deskripsi Isi Type & 

Length 
Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_rumahsakit Identitas rumah sakit Varchar Tidak  
Nama Nama rumah sakit Varchar   
Alamat Alamat rumah sakit Varchar   
No_telp Nomor telp yang dapat dihubungi Varchar   

A.8 Spesifikasi Tabel Perguruantinggi 
Nama tabel  : perguruantinggi 
Deskripsi isi : Berisi tentang perguruan tinggi yang ada 
Primary Key : Id_perguruantinggi 
Volume : +  8 record  
Perkiraan Laju : +  1 record per 2 tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_perguruantinggi Identitas perguruantinggi Varchar Tidak  
Nama Nama Perguruan Tinggi Varchar   
Alamat Alamat Perguruan Tinggi Varchar   
No_telp No telp yang dapat dihubungi Varchar   

A.9 Spesifikasi Tabel Jalan Utama 
Nama tabel  : jalanutama 
Deskripsi isi : Berisi informasi jalan utama yang ada 
Primary Key : Id_jalanutama 
Volume : +  15 record 
Perkiraan Laju : +  1 record per 2 tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL 

Default 

Shape Bentuk dari peta Varchar   
Id_jalanutama Identitas jalan utama Varchar Tidak  
Nama Nama jalan utama Varchar   
Lokasi Lokasi dari jalan utama Varchar   

A.10 Spesifikasi Tabel Sarana Olahraga 
Nama tabel  : saranaolahraga 
Deskripsi isi : Berisi tentang sarana olahraga yang ada 
Primary Key : Id_saranaolahraga 
Volume : +  11 record  
Perkiraan Laju : +  1 record per 2 tahun 
Daftar Field 

Nama  field Deskripsi Isi Type & 
Length 

Boleh 
NULL Default 

Shape Bentuk dari peta Varchar   
Id_saranaolahraga Identitas sarana olahraga Varchar Tidak  
Nama Nama sarana olahraga Varchar   
Alamat Alamat sarana olahraga Varchar   
jenis Jenis olahraga Varchar   
No_telp No telp yang dapat dihubungi Varchar   
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LAMPIRAN B PERANCANGAN RINCI FUNGSIONAL 

B.1   Spesifikasi fungsi / proses F 1 
Identifikasi / Nama : Pilihan penyajian fasilitas umum 
Deskripsi isi : User memilih fasilitas umum yang dibutuhkan 
Jenis : Form entry columnar 

B.1.1 Spesifikasi Tabel Input 
Tidak ada. 

B.1.2 Spesifikasi Tabel Output 
Tidak ada. 

B.1.3 Spesifikasi Layar Utama 
x_

P  e  t a

L e g e n d :

        S aran a in f ras tru ktu r

        K aw as an in d u s tr i

        K aw as an p ar iw is ata

        K aw as an p erd ag an g an

         H otel

         B an k

        R u m ah s ak it

        P erg u ru an tin g g i

        J alan u tam a

        S aran aolah rag a

 

B.1.4 Spesifikasi Query 
Tidak ada. 

B.1.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.1.6 Spesifikasi Function Key / Objek Pada Layar  
Id_Objek Jenis Keterangan 

ListFasum List/Menu List Fasilitas Umum yang ada yang harus dipilih user 

txtKeyword Text Field Keyword masukan dari user 

BtnOK Button 
Jika diklik akan menyajikan fasilitas umum sesuai 

pilihan 

B.1.7 Spesifikasi Layar Pesan 
  Tidak ada. 
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B.1.8 Spesifikasi Proses / Algoritma 

B.1.8.1 F 1.  : Pilihan jenis fasilitas umum 
Objek terkait  : Link 
Event  : Click 

 
Initial State (IS): Pilih jenis fasilitas umum atau memasukkan 
keyword 
 
Final State (FS): Menyajikan data fasilitas umum sesuai pilihan 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Pilih tabel=list/menu atau keyword dan salah satu field=keyword 
Jika hanya memilih jenis fasilitas umum maka 
   Tampilkan tabel sesuai jenis yang dipilih 
Selain itu keyword=salah satu field maka 
   Tampilkan objek pada peta 
 

B.1.9 Spesifikasi Report 
Tidak ada. 
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B.2 Spesifikasi fungsi / proses F 2 
Identifikasi / Nama : Penyajian data sarana infrastruktur 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.2.1 Spesifikasi Tabel Input 
Tabel input = saranainfrastruktur 

B.2.2 Spesifikasi Tabel Output 
Tidak ada. 

B.2.3 Spesifikasi Layar Utama 
x x_ID information for Saranainfrastruktur_

Legend:
NO Nama Alamat No_telp No_fax

P e t a

         Perguruantinggi

         Jalanutama

         Saranaolahraga

         Saranainfrastruktur

         Kawasanindustri

         Kawasanpariwisata

         Kawasanperdagangan

           Hotel

           Bank

          Rumahsakit

 

B.2.4 Spesifikasi Query 
Tidak ada. 

B.2.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.2.6 Spesifikasi Function Key / Objek Pada Layar  
  Tidak ada. 

B.2.7 Spesifikasi Layar Pesan 
  Tidak ada. 
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B.2.8 Spesifikasi Proses / Algoritma 

B.2.8.1 F 2.  : Penyajian data infrastruktur 
Objek terkait  : Link 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.2.8.2 F 2.  : Penyajian data infrastruktur 
Objek terkait  : Objek 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

B.2.9 Spesifikasi Report 
Tidak ada. 
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B.3 Spesifikasi fungsi / proses F 3 
Identifikasi / Nama : Penyajian data kawasan industri 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.3.1 Spesifikasi Tabel Input 
Tabel input = kawasanindustri 

B.3.2 Spesifikasi Tabel Output 
Tidak ada. 

B.3.3 Spesifikasi Layar Utama 

x
x_ID information for Kawasanindustri_

Legend:
NO Nama Alamat No_telp No_fax

P e t a

       Perguruantinggi

        Jalanutama

       Saranaolahraga

       Saranainfrastruktur

       Kawasanindustri

       Kawasanpariwisata

       Kawasanperdagangan

         Hotel

         Bank

        Rumahsakit

 

B.3.4 Spesifikasi Query 
Tidak ada. 

B.3.5 Spesifikasi Field Data Pada Layar 
Tidak ada. 

B.3.6 Spesifikasi Function Key / Objek Pada Layar 
Tidak ada.  

B.3.7 Spesifikasi Layar Pesan 
Tidak ada. 
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B.3.8 Spesifikasi Proses / Algoritma 

B.3.8.1 F 3.  : Penyajian data kawasan industri 
Objek terkait  : Link 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.3.8.2 F 3.  : Penyajian data kawasan industri 
Objek terkait  : Objek 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

B.3.9 Spesifikasi Report 
Tidak ada. 
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B.4 Spesifikasi fungsi / proses F 4 
Identifikasi / Nama : Penyajian data kawasan pariwisata 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.4.1 Spesifikasi Tabel Input 
Tabel input = kawasanpariwisata 

B.4.2 Spesifikasi Tabel Output 
Tidak ada. 

B.4.3 Spesifikasi Layar Utama 
x x_ID  in form ation for K awasanpariw isata_

Leg en d:
N O N am a A lam at N o_telp

P  e  t a

         P erguruan tingg i

         Jalanutam a

         S aranaolahraga

         S aranain fras truktu r

         K aw asanindus tri

         K aw asanpariw isata

         K aw asanperdagangan

           H otel

           B ank

          R um ahsakit

 

B.4.4 Spesifikasi Query 
Tidak ada. 

B.4.5 Spesifikasi Field Data Pada Layar  
Tidak ada. 

B.4.6 Spesifikasi Function Key / Objek Pada Layar 
Tidak ada.  

B.4.7 Spesifikasi Layar Pesan 
Tidak ada. 
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B.4.8 Spesifikasi Proses / Algoritma 

B.4.8.1 F 4.  : Penyajian data pariwisata 
Objek terkait  : Link 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.4.8.2 F 4.  : Penyajian data pariwisata 
Objek terkait  : Objek 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

B.4.9 Spesifikasi Report 
Tidak ada. 
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B.5 Spesifikasi fungsi / proses F 5 
Identifikasi / Nama : Penyajian data kawasan perdagangan 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.5.1 Spesifikasi Tabel Input 
Tabel input = kawasanperdagangan 

B.5.2 Spesifikasi Tabel Output 
Tidak ada. 

B.5.3 Spesifikasi Layar Utama 
x_ID information for Kawasanperdagangan

NO Nama Alamat

Legend:

         Perguruantinggi

         Jalanutama

         Saranaolahraga

         Saranainfrastruktur

         Kawasanindustri

         Kawasanpariwisata

         Kawasanperdagangan

           Hotel

           Bank

          Rumahsakit

_ x

P e t a

 

B.5.4 Spesifikasi Query 
Tidak ada. 

B.5.5 Spesifikasi Field Data Pada Layar  
Tidak ada. 

B.5.6 Spesifikasi Function Key / Objek Pada Layar  
Tidak ada. 

B.5.7 Spesifikasi Layar Pesan 
Tidak  ada. 
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B.5.8 Spesifikasi Proses / Algoritma 

B.5.8.1 F 5.  : Penyajian data perdagangan 
Objek terkait  : Link 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.5.8.2 F 5.  : Penyajian data perdagangan 
Objek terkait  : Objek 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

 

B.5.9 Spesifikasi Report 
Tidak ada. 
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B.6 Spesifikasi fungsi / proses F 6 
Identifikasi / Nama : Penyajian data hotel 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.6.1 Spesifikasi Tabel Input 
Tabel input = hotel 

B.6.2 Spesifikasi Tabel Output 
Tidak ada. 

B.6.3 Spesifikasi Layar Utama 
x_ID  in form ation  for H otel

N O N am a A lam at N o_ telp N o_ faxJ en is
L eg en d :

         P erguruantingg i

         J alanutam a

         S aranaolahraga

         S aranain fras truktur

         K aw as an indus tri

         K aw as anpariw is ata

         K aw as anperdagangan

           H otel

           B ank

          R um ahs akit

_ x

P  e  t a

 

B.6.4 Spesifikasi Query 
Tidak ada. 

B.6.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.6.6 Spesifikasi Function Key / Objek Pada Layar  
  Tidak ada. 

B.6.7 Spesifikasi Layar Pesan 
  Tidak ada. 
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B.6.8 Spesifikasi Proses / Algoritma 

B.6.8.1 F 6.  : Penyajian data hotel 
Objek terkait  : Link 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.6.8.2 F 6.  : Penyajian data hotel 
Objek terkait  : Objek 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

 

B.6.9 Spesifikasi Report 
Tidak ada. 
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B.7 Spesifikasi fungsi / proses F 7 
Identifikasi / Nama : Penyajian data bank 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.7.1 Spesifikasi Tabel Input 
Tabel input = bank 

B.7.2 Spesifikasi Tabel Output 
Tidak ada. 

B.7.3 Spesifikasi Layar Utama 
x_ID information for Bank

NO Nama Alamat No_telp

Legend:

         Perguruantinggi

         Jalanutama

         Saranaolahraga

         Saranainfrastruktur

         Kawasanindustri

         Kawasanpariwisata

         Kawasanperdagangan

           Hotel

           Bank

          Rumahsakit

_ x

P e t a

 

B.7.4 Spesifikasi Query 
Tidak ada. 

B.7.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.7.6 Spesifikasi Function Key / Objek Pada Layar 
Tidak ada.  

B.7.7 pesifikasi Layar Pesan 
  Tidak ada. 
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B.7.8 Spesifikasi Proses / Algoritma 

B.7.8.1 F 7.  : Penyajian data bank 
Objek terkait  : Link 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.7.8.2 F 7.  : Penyajian data bank 
Objek terkait  : Objek 
Event  : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

 

B.7.9 Spesifikasi Report 
Tidak ada. 
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B.8 Spesifikasi fungsi / proses F 8 
Identifikasi / Nama : Penyajian data rumah sakit 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.8.1 Spesifikasi Tabel Input 
Tabel input = rumahsakit 

B.8.2 Spesifikasi Tabel Output 
Tidak ada. 

B.8.3 Spesifikasi Layar Utama 
x_ID  in form ation  for R um ahs akit

N O N am a A lam at N o_telp

L egen d:

         P erguruan tingg i

         J alanu tam a

         S aranaolahraga

         S aranain fras truktur

         K aw as an indus tri

         K aw as anpariw is ata

         K aw as anperdagangan

           H otel

           B ank

          R um ahsakit

_ x

P  e  t a

 

B.8.4 Spesifikasi Query 
Tidak ada. 

B.8.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.8.6 Spesifikasi Function Key / Objek Pada Layar 
Tidak ada.  

B.8.7 Spesifikasi Layar Pesan 
  Tidak ada. 
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B.8.8 Spesifikasi Proses / Algoritma 

B.8.8.1 F 8.  : Penyajian data rumah sakit 
Objek terkait   : Link 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.8.8.2 F 8.  : Penyajian data rumah sakit 
Objek terkait   : Objek 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

 

B.8.9 Spesifikasi Report 
Tidak ada. 
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B.9 Spesifikasi fungsi / proses F 9 
Identifikasi / Nama : Penyajian data perguruan tinggi 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.9.1 Spesifikasi Tabel Input 
Tabel input = perguruantinggi 

B.9.2 Spesifikasi Tabel Output 
Tidak ada. 

B.9.3 Spesifikasi Layar Utama 
x_ID information for Kawasanpariwisata

NO Nama Alamat No_telp

Legend:

         Perguruantinggi

         Jalanutama

         Saranaolahraga

         Saranainfrastruktur

         Kawasanindustri

         Kawasanpariwisata

         Kawasanperdagangan

           Hotel

           Bank

          Rumahsakit

_ x

P e t a

 

B.9.4 Spesifikasi Query 
Tidak ada. 

B.9.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.9.6 Spesifikasi Function Key / Objek Pada Layar 
Tidak ada.  

B.9.7 Spesifikasi Layar Pesan 
  Tidak ada. 
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B.9.8 Spesifikasi Proses / Algoritma 

B.9.8.1 F 9.  : Penyajian data perguruan tinggi 
Objek terkait   : Link 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.9.8.2 F 9.  : Penyajian data perguruan tinggi 
Objek terkait   : Objek 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

 

B.9.9 Spesifikasi Report 
Tidak ada. 
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B.10 Spesifikasi fungsi / proses F 10 
Identifikasi / Nama : Penyajian data jalan utama 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.10.1 Spesifikasi Tabel Input 
Tabel input = jalanutama 

B.10.2 Spesifikasi Tabel Output 
Tidak ada. 

B.10.3 Spesifikasi Layar Utama 
x_ID information for Kawasanpariwisata

NO Nama Alamat No_telp

Legend:

         Perguruantinggi

         Jalanutama

         Saranaolahraga

         Saranainfrastruktur

         Kawasanindustri

         Kawasanpariwisata

         Kawasanperdagangan

           Hotel

           Bank

          Rumahsakit

_ x

P e t a

 

B.10.4 Spesifikasi Query 
Tidak ada. 

B.10.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.10.6 Spesifikasi Function Key / Objek Pada Layar 
Tidak ada.  

B.10.7 Spesifikasi Layar Pesan 
  Tidak ada. 
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B.10.8 Spesifikasi Proses / Algoritma 

B.10.8.1 F 10.  : Penyajian data jalan utama 
Objek terkait   : Link 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.10.8.2 F 10.  : Penyajian data jalan utama 
Objek terkait   : Objek 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

 

B.10.9 Spesifikasi Report 
Tidak ada. 
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B.11 Spesifikasi fungsi / proses F 11 
Identifikasi / Nama : Penyajian data sarana olahraga 
Deskripsi isi : Penyajian sesuai masukan user pada F1 
Jenis : Form entry columnar 

B.11.1 Spesifikasi Tabel Input 
Tabel input = saranaolahraga 

B.11.2 Spesifikasi Tabel Output 
Tidak ada. 

B.11.3 Spesifikasi Layar Utama 
x_ID  inform ation for Saranaolahraga

N O N am a Alam at N o_telp N o_fax
Legend:

         P erguruantinggi

         Jalanutam a

         S aranaolahraga

         S aranainfras truktur

         K awasanindustri

         K awasanpariw isata

         K awasanperdagangan

           H otel

           Bank

          R um ahsakit

_ x

P  e t a

 

B.11.4 Spesifikasi Query 
Tidak ada. 

B.11.5 Spesifikasi Field Data Pada Layar  
  Tidak ada. 

B.11.6 Spesifikasi Function Key / Objek Pada Layar 
Tidak ada  

B.11.7 Spesifikasi Layar Pesan 
  Tidak ada 
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B.11.8 Spesifikasi Proses / Algoritma 

B.11.8.1 F 11.  : Penyajian data sarana olahraga 
Objek terkait   : Link 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): Objek tampil pada peta 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
Link diklik muncul objek pada peta 
 

B.11.8.2 F 11.  : Penyajian data sarana olahraga 
Objek terkait   : Objek 
Event   : Click 

 
Initial State (IS): - 
 
Final State (FS): data rinci objek 
 
Spesifikasi Proses/algoritma: 
Koneksi ke database 
objek pada peta di klik maka tampil data rinci objek 
 

 

B.11.9 Spesifikasi Report 
Tidak ada. 
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LAMPIRAN C DAFTAR RINCI FILE DAN DATA 

C.1 Struktur direktori 

C.1.1 Direktori pengembangan 
Direktori pengembangan berada dalam direktori ta2.4 yang didalamnya terdiri dari 
direktori: 
1. laporan, berisi laporan pembuatan Aplikasi terdiri dari file *.doc. 
2. project_apr, berisi file project Fasilitas Umum Batam terdiri dari *.apr. 
3. project_php, berisi file *.php yang digunakan untuk menampilkan project melalui 

internet explorer. 
4. project_shp, berisi file *.shp, *.shx, *.dbf dari Fasilitas Umum Batam. 
5. toMySQL, berisi file hasil export dari project. Masing masing terdiri dari connect.php, 

*.bmp, *.sql. 

C.1.2 Direktori operasional 
Direktori pengembangan berada dalam direktori ta2.4 yang didalamnya terdiri dari file-file 
php dan direktori: 
1. tools, berisi images penunjang aplikasi. 

C.2 Isi Direktori : C:\ ta2.4 
 Volume in drive C is Local Disk 
 Volume Serial Number is E4FE-3F29 
 
 Directory of C:\ta2.4 
 
21/07/2004  10:00       <DIR>          . 
21/07/2004  10:00       <DIR>          .. 
21/07/2004  10:04       <DIR>          laporan 
19/07/2004  14:44       <DIR>          project_apr 
19/07/2004  14:52       <DIR>          project_php 
19/07/2004  14:44       <DIR>          project_shp 
19/07/2004  14:47       <DIR>          toMySQL 
               0 File(s)              0 bytes 
               7 Dir(s)      43.814.912 bytes free 

C.2.1 Isi Subdirektori : C:\ta2.4\laporan 
 Volume in drive C is Local Disk 
 Volume Serial Number is E4FE-3F29 
 
 Directory of C:\ta2.4\laporan 
 
21/07/2004  10:04       <DIR>          . 
21/07/2004  10:04       <DIR>          .. 
01/04/2004  08:57               74.752 bab1&2.DOC 
29/05/2004  15:32            2.081.792 bab3 .doc 
01/06/2004  13:07              744.448 bab4.doc 
21/07/2004  09:52               81.408 bab5&6.doc 
28/05/2004  16:24               83.968 lampiranA.doc 
02/06/2004  17:15            2.411.520 lampiranB.doc 
21/07/2004  10:01               63.488 lampiranC&D.doc 
               7 File(s)      5.541.376 bytes 
               2 Dir(s)      43.814.912 bytes free 
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C.2.2 Isi Subdirektori : C:\ta2.4\project_apr 
 Volume in drive C is Local Disk 
 Volume Serial Number is E4FE-3F29 
 
 Directory of C:\ta2.4\project_apr 
 
19/07/2004  14:44       <DIR>          . 
19/07/2004  14:44       <DIR>          .. 
19/07/2004  12:10              116.964 projectbatam.apr 
               1 File(s)        116.964 bytes 
               2 Dir(s)      43.765.760 bytes free 

C.2.3 Isi Subdirektori : C:\ta2.4\project_php 
 Volume in drive C is Local Disk 
 Volume Serial Number is E4FE-3F29 
 
 Directory of C:\ta2.4\project_php 
 
19/07/2004  14:52       <DIR>          . 
19/07/2004  14:52       <DIR>          .. 
14/07/2004  17:26                   93 connect.php 
17/07/2004  14:01                  448 footer.htm 
19/07/2004  14:26                1.104 index.php 
05/10/2001  14:24                1.709 legend.php 
06/12/2001  13:29                8.760 loadsvg.php 
16/07/2004  13:28               24.344 map.php 
19/07/2004  14:22               39.025 map_page.php 
19/07/2004  14:52       <DIR>          tools 
               7 File(s)         75.483 bytes 
               3 Dir(s)      43.765.760 bytes free 

C.2.4 Isi Subdirektori : C:\ta2.4\project_shp 
 Volume in drive C is Local Disk 
 Volume Serial Number is E4FE-3F29 
 
 Directory of C:\ta2.4\project_shp 
 
19/07/2004  14:44       <DIR>          . 
19/07/2004  14:44       <DIR>          .. 
14/07/2004  15:03                  267 bank.dbf 
14/07/2004  12:02                  128 bank.shp 
14/07/2004  12:02                  108 bank.shx 
19/07/2004  12:10                  393 batuampar.dbf 
13/07/2004  17:15               16.700 batuampar.shp 
13/07/2004  17:15                  140 batuampar.shx 
16/07/2004  11:39                  349 hotel.dbf 
16/07/2004  11:39                  128 hotel.shp 
16/07/2004  11:39                  108 hotel.shx 
17/07/2004  14:47                  276 jalanutama.dbf 
14/07/2004  11:39                  820 jalanutama.shp 
14/07/2004  11:39                  116 jalanutama.shx 
14/07/2004  15:05                  412 kawasanindustri.dbf 
14/07/2004  14:24                  140 kawasanindustri.shp 
14/07/2004  14:24                  116 kawasanindustri.shx 
14/07/2004  12:17                  193 kawasanpariwisata.dbf 
14/07/2004  12:10                  100 kawasanpariwisata.shp 
14/07/2004  12:10                  100 kawasanpariwisata.shx 
19/07/2004  09:30                  307 kawasanperdagangan.dbf 
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19/07/2004  09:30                  128 kawasanperdagangan.shp 
19/07/2004  09:30                  108 kawasanperdagangan.shx 
14/07/2004  15:18                   76 perguruantinggi.aih 
14/07/2004  15:18               11.264 perguruantinggi.ain 
14/07/2004  15:18                  281 perguruantinggi.dbf 
14/07/2004  11:48                  128 perguruantinggi.shp 
14/07/2004  11:48                  108 perguruantinggi.shx 
15/07/2004  15:50                  281 rumahsakit.dbf 
15/07/2004  15:50                  128 rumahsakit.shp 
15/07/2004  15:50                  108 rumahsakit.shx 
19/07/2004  11:42                  417 
saranainfrastruktur.dbf 
19/07/2004  11:42                  320 
saranainfrastruktur.shp 
19/07/2004  11:42                  108 
saranainfrastruktur.shx 
14/07/2004  12:21                  225 saranaolahraga.dbf 
14/07/2004  12:06                  100 saranaolahraga.shp 
14/07/2004  12:06                  100 saranaolahraga.shx 
              35 File(s)         34.781 bytes 
               2 Dir(s)      43.765.760 bytes free 

C.2.5 Isi Subdirektori : C:\ta2.4\toMySQL 
 Volume in drive C is Local Disk 
 Volume Serial Number is E4FE-3F29 
 
 Directory of C:\ta2.4\toMySQL 
 
19/07/2004  14:47       <DIR>          . 
19/07/2004  14:47       <DIR>          .. 
19/07/2004  14:37       <DIR>          bank5 
19/07/2004  14:37       <DIR>          batuampar1 
19/07/2004  14:37       <DIR>          hotel8 
19/07/2004  14:37       <DIR>          industri11 
19/07/2004  14:37       <DIR>          infrastruktur2 
19/07/2004  14:37       <DIR>          jalan3 
19/07/2004  14:37       <DIR>          olahraga7 
19/07/2004  14:37       <DIR>          pariwisata10 
19/07/2004  14:37       <DIR>          perdagangan9 
19/07/2004  14:37       <DIR>          perguruantinggi4 
19/07/2004  14:37       <DIR>          rumahsakit6 
               0 File(s)              0 bytes 
              13 Dir(s)      43.687.936 bytes free 
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LAMPIRAN D RINCI TESTING 

D.1 Tim penguji 
1. Nama : Yuswita 

Initial : yw 
2. Nama : Khoharuddin 

Initial : kh 

D.2 Hasil Rinci Pengujian 
No No 

Fungsi Deskripsi Fungsional Kelompok 
Uji Prosedur & Kasus uji Hasil yang 

diharap Hasil Test Tester Tgl Testing 

1 F1 
Menu Utama 
Pilihan Penyajian 
fasilitas umum 

Normal Klik halaman web Layar menu 
utama tampil Diterima yw 7 Agustus 

2004 

2 F2 Penyajian data sarana 
infrastruktur Normal Pilih menu fasilitas umum infrastruktur 

kemudian klik menu open attribute table 
Layar informasi 
data tampil Diterima yw 7 Agustus 

2004 

3 F3 Penyajian data kawasan 
industri Normal 

Pilih menu fasilitas umum kawasan 
industri kemudian klik menu open 
attribute table 

Layar informasi 
data tampil Diterima kh 7 Agustus 

2004 

4 F4 Penyajian data kawasan 
pariwisata Normal Pilih menu fasilitas umum pariwisata 

kemudian klik menu open attribute table 
Layar informasi 
data tampil Diterima yw 7 Agustus 

2004 
5 F5 Penyajian data kawasan  

perdagangan Normal Pilih menu fasilitas umum perdagangan 
kemudian klik menu open attribute table 

Layar informasi 
data tampil Diterima kh 7 Agustus 

2004 
6 F6 Penyajian data hotel Normal Pilih menu fasilitas umum hotel kemudian 

klik menu open attribute table 
Layar informasi 
data tampil Diterima kh 7 Agustus 

2004 
7 F7 Penyajian data bank Normal Pilih menu fasilitas umum bank kemudian 

klik menu open attribute table 
Layar informasi 
data tampil Diterima yw 7 Agustus 

2004 
8 F8 Penyajian data rumah 

sakit Normal Pilih menu fasilitas umum rumah sakit 
kemudian klik menu open attribute table 

Layar informasi 
data tampil Diterima kh 7 Agustus 

2004 

9 F9 Penyajian data 
perguruan tinggi Normal 

Pilih menu fasilitas umum perguruan 
tinggi kemudian klik menu open attribute 
table 

Layar informasi 
data tampil Diterima kh 7 Agustus 

2004 
10 F10 Penyajian data jalan Normal Pilih menu fasilitas umum jalan utama Layar informasi Diterima yw 7 Agustus 
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No No 
Fungsi Deskripsi Fungsional Kelompok 

Uji Prosedur & Kasus uji Hasil yang 
diharap Hasil Test Tester Tgl Testing 

utama kemudian klik menu open attribute table data tampil 2004 

11 F11 Penyajian data sarana 
olahraga Normal 

Pilih menu fasilitas umum sarana 
olahraga kemudian klik menu open 
attribute table 

Layar informasi 
data tampil Diterima kh 7 Agustus 

2004 

12 F12 Penyajian data sarana  
infrastruktur Normal Klik sarana infrastruktur pada peta Layar informasi 

data tampil Diterima kh 7 Agustus 
2004 

13 F13 Penyajian data kawasan 
industri Normal Klik kawasan industri peta Layar informasi 

data tampil Diterima yw 7 Agustus 
2004 

14 F14 Penyajian data kawasan 
pariwisata Normal Klik kawasan pariwisata pada peta Layar informasi 

data tampil Diterima kh 7 Agustus 
2004 

15 F15 Penyajian data kawasan  
perdagangan Normal Klik kawasan perdagangan pada peta Layar informasi 

data tampil Diterima kh 7 Agustus 
2004 

16 F16 Penyajian data hotel Normal Klik hotel pada peta Layar informasi 
data tampil Diterima yw 7 Agustus 

2004 
17 F17 Penyajian data bank Normal Klik bank pada peta Layar informasi 

data tampil Diterima kh 7 Agustus 
2004 

18 F18 Penyajian data rumah 
sakit Normal Klik rumah sakit pada peta Layar informasi 

data tampil Diterima kh 7 Agustus 
2004 

19 F19 Penyajian data 
perguruan tinggi Normal Klik perguruan tinggi pada peta Layar informasi 

data tampil Diterima yw 7 Agustus 
2004 

20 F20 Penyajian data jalan 
utama Normal Klik jalan utama pada peta Layar informasi 

data tampil Diterima kh 7 Agustus 
2004 

21 F21 Penyajian data sarana 
olahraga Normal Klik sarana olahraga pada peta Layar informasi 

data tampil Diterima kh 7 Agustus 
2004 

 
 



  1 

LAMPIRAN E SKENARIO DEMO 

E.1 Tampilan Awal 

 

 

E.2 Legend 
Melihat fasilitas umum berupa Sarana Infrastruktur, Kawasan Industri dan hotel.  
Legend, Layer yang ditampilkan sesuai check box pada legend yang aktif. 

 

E.3 Identify Feature 
Melihat informasi dari salah satu Sarana Infrastruktur yang ada. 
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 Identify feature, memberi informasi berdasarkan daerah yang dipilih. 

- Pilih button Identify feature, pada footer tampil fungsinya. 

 

 
- Saat cursor diarahkan pada peta maka warna peta akan berubah. 

- Klik salah satu fasilitas umum pada peta. 

- Informasi berupa data atribut akan muncul pada window baru. 

 

E.4 Zoom In 
Memperbesar tampilan peta. 

Zoom in, memperbasar tampilan peta. 

- Pilih button Zoom In. 

 

 
- Klik dan drag daerah yang akan diperbesar. 
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- Peta akan diperbesar 

 

E.5 Zoom Out 
Memperkecil tampilan peta. 

 Zoom out, memperkecil tampilan peta. 

- Pilih button Zoom Out. 

 

 
- Klik daerah yang akan diperkecil. 

- Peta akan diperkecil. 

 

E.6 Pan View 
Karena peta letaknya terlalu kebawah, agar lebih berada di tengah.  
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 Pan view, menggeser tampilan peta. 

- Pilih button Pan View. 

 

 
- Klik dan drag sesuai pergeseran yang diinginkan. 

 
- Peta akan bergeser. 
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E.7 Return to Original Map 
Karena peta terlalu kecil, mengembalikan pada ukuran semula.  

 Return to original map, Klik pada peta untuk mengembalikan peta pada ukuran semula.  

 

 

 

E.8 Filter Data 
Mencari wilayah kecamatan Batu Ampar.  

 Filter data, mencari data pada peta berdasarkan data attribut. 

- Klik pada salah satu legend. 

- Pilih button Filter data. 

 

 
- Akan muncul form berisi pilihan data attribut, pilih. 
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- Jika pilih Highlight matching features, maka data yang cocok akan ditampilkan pada peta 

dengan warna kuning. 

 
- Jika pilih Show only matching features, maka data yang cocok saja yang akan ditampilkan 

pada peta 

 

E.9 Open Attribut Data 
Menampilkan data atribut seluruh kawasan perdagangan 

 Open attribut data, membuka data attribut berdasarkan legend. 

- Klik pada salah satu legend. 

- Pilih button Open attribut data. 
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- Akan muncul window baru berisi data attribut sesuai legend yang dipilih. 
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LAMPIRAN F PEMBUATAN OBJEK DAN TABEL PADA ARCVIEW 

F.1 Spesifikasi Project 
Dalam ArcView, secara difault project baru akan terbentuk ketika membuka ArcView. Untuk 
pembuatan project baru dilakukan melalui menu File > New Project, maka akan muncul project 
baru . Untuk menyimpan project menggunakan menu File > Save Project atau File > Save Project 
As. 

F.2 Spesifikasi Objek 

F.2.1 Penambahan Objek 
Pembuatan objek baru pada ArcView dilakukan melalui menu View > New Theme, akan 
muncul dialog untuk memilih jenis objek peta.  
 

 
 

Objek peta yang dapat dipilih terdiri dari tiga jenis: 
1. Point, objek Point mewakili titik lokasi, misalnya lokasi sarana olahraga. 
2. Line, objek Line mewakili objek peta berupa garis, misalnya ruas jalan. 
3. Polygon, objek Polygon mewakili objek peta berupa luasan, misalnya batas 

wilayah. 
 

Setelah jenis objek peta dipilih, isi nama file yang akan dibuat, kemudian akan muncul 
layer baru pada View. Contoh layer baru dapat dilihat pada gambar di bawah ini: 
 

 
 
Kotak status kenampakkan layer diberi garis putus-putus, menandakan layer tersebut dapat 
diedit(dilakukan pengambaran, pegubahan atau penghapusan objek). Untuk membuat objek 
baru gunakan tool untuk pengambaran. Untuk menyimpan objek peta, pilih menu Theme > 
Save Edits.  
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F.2.2 Pengubahan Objek 
Pengubahan objek pada ArcView dilakukan dengan memilih objek yang akan diedit 
kemudian pilih menu Theme > Start Edit, maka kotak status kenampakkan layer diberi 
garis putus-putus menandakan objek yang ada pada layer dapat diedit. 
 
Jika inggin menyimpan objek yang telah diedit, pilih menu Theme > Save Edits. Untuk 
Menyelesaikan editing, pilih menu Theme > Stop Editing. 

F.2.3 Menghapus Objek  
Penghapusan objek pada ArcView dilakukan dengan memilih layer dari objek yang 
dihapus kemudian pilih menu Edit > Delete Themes, maka semua objek yang ada pada 
layer akan terhapus.  
 
Bila hanya ingin menghapus satu atau beberapa objek, melalui menu Theme > Star Edit, 
jika kotak status kenampakan layer sudah diberi garis putus-putus maka kita dapat 
melakukan penghapusan objek, dengan memilih objek yang akan dihapus kemudian pilih 
menu Edit > Delete Features. 
 
Jika ingin menyimpan, pilih menu Theme > Save Edits. Untuk Menyelesaikan editing, pilih 
menu Theme > Stop Editing. 

F.3 Spesifikasi Tabel 
Pada ArcView, komponen table yang dapat mengakomodasi data tekstual dibedakan, salah 
satunya adalah Feature Table yang mempunyai karakteristik antara lain: 

1. Feature Table merupakan data tekstual yang terkait langsung dengan objek peta. 
Penambahan, penghapusan dan seleksi yang dilakukan pada objek peta akan selalu 
sinkron dengan penambahan, penghapusan dan seleksi record pada Feature Table, 
demikian sebaliknya. 

2. Feature Table dibuat bersamaan dengan pembuatan objek peta. 
3. Pada Feature Table dikenal field khusus bernama Shape yang mendefinisikan link dengan 

objek peta. Sebuah Feature Table akan mengandung satu field ini. 
4. Untuk melakukan akses terhadap Feature Table dapat dilakukan dengan cara menekan 

tombol Open Theme Table, atau memilih menu Theme > Table ketika layer peta sedang 
aktif. 

Contoh tampilan Feature Table pada browser Table dapat dilihat pada gambar dibawah ini: 
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F.3.1 Pembuatan dan Modifikasi Tabel 
Feature Table dibuat ketika objek peta (pada Theme) dibuat, tabel harus dalam keadaan 
edit table, jika akan dilakukan modifikasi. Untuk membuat table dapat diedit, pilih menu 
Table > Start Editing. 

F.3.2 Modifikasi Field 
  ArcView mengenal jenis field sebagai berikut: 

1. Number 
Number mewakili data bilangan, misalnya: 100, 12.323. 

2. String 
String mewakili data karakter alfanumerik seperti “Peta Wilayah”. 

3. Boolean 
Boolean mewakili data lojik (True atau False). 

4. Date 
Date mewakili data tanggal. 

 
Penambahan field dapat dilakukan dengan memilih menu Edit > Add Field, akan muncul 
tampilan seperti pada gambar di bawah ini: 
 

 
 

Penghapusan field dapat dilakukan dengan cara, pilih/aktifkan field yang akan dihapus 
pada Browser Table. 
 

 
 

Pada gambar di atas, field yang aktif adalah field “Nama”, kemudian pilih menu Edit > 
Delete Field. 
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LAMPIRAN G OPENSVGMAPSERVER 1.01 

G.1 Arsitektur OpenSVGMapServer 1.01 

import
Browser

OpenSVGMapServer 1.01

php

tomysql.apr/ tomysql.ave

gambar
pendukung

MySQL

Aplikasi
ditampilkan

ArcView

project *.apr

Koneksi database

Export

eksekusi ke database

HASIL EXPORT

*.sql

*.bmp

connect.php

 

G.2 File 

G.2.1 Batasan 
1. Script hanya bekerja dengan Internet Explorer 4.x dan 5.x. Fungsinya akan lebih baik 

bila berjalan di Netscape browser. 
2. Tidak menunjang data raster 
3. Perlu perbaikan script. 

G.2.2 Requirement 
1. Komputer dapat menjalankan ArcView GIS 3.x untuk export 
2. Data Geografik dalam format apapun yang bisa disupport oleh ArcView. 
3. Web server menggunakan MySQL dan PHP. 
4. Untuk tampilan menggunakan Internet Explorer 4.0+ dengan Adobe SVGViewer 

plug-in. 

G.2.3 Isi Direktori 
Nama File Deskripsi Keterangan 

tomysql.apr 

ArcView 3.0a project, berisi script tomysql. Script dipanggil 

dengan memilih “Export To Mysql” dari menu View dalam 

View Object 

tomysql.ave Versi text dari script yang digunakan dalam tomysql.apr 

File Export yang 

digunakan dalam 

ArcView GIS 

map_frame.php Halaman frameset berisi map_page.php dan footer.htm Files delivering SVG 
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Nama File Deskripsi Keterangan 

map_page.php 

Menghasilkan halaman html meliputi toolbox, legend, 

peta(emmbedeed SVG yang dipanggil dari map.php) dan 

attribut data seperti Javascript arrays. Ecmascript untuk 

menghandle filtering, dan menampilkan data atrribut. 

map.php 
Menghasilkan file SVG dengan melakukan query ke database 

dan untuk tiap layer  

legend.php 

Menghasilkan gambar legend sebagai file SVG untuk setiap 

layer. Mengambil paramater LayerID(untuk Layer mana 

legend tersebut) 

loadSVG.php Query dari semua layer dalam Project  

footer.htm Untuk menampilkan inisialisasi dalam footer frame  

 

Tools Berisi gambar dari icon yang digunakan Direktori lain 

view_name.bmp 

atau 

view_name.png 

Gambar tampilan peta yang diambil dari ArcView 

connect.php 
File untuk koneksi ke database meliputi parameter (server, 

username dan password) 

View_name.sql File mysql dump untuk di import ke database MySQL 

File yang dihasilkan 

dari script tomysql 

G.2.4 Menyiapkan Data ArcView dan Export (Step 1) 
1. Buka project di ArcView. 
2. Import project tomysql.apr. 
3. Akan muncul menu View > Export To MySQL 
4. Set properties  dari menu View > Properties.  
5. Set skala maksimum dan/atau skala minimum dari menu  Theme > Properties. 
6. Aktifkan themes yang akan di export.  
7. Atur tampilan Window sesuai ukuran peta yang akan ditampilkan pada halaman web.  
8. Pilih menu View > Export To MySQL  
9. Script ini akan menghasilkan file-file dari project.  
10. Spesifikasikan tempat penyimpanan file yang diinginkan, click OK: 

 

 
 

11. Masukkan password administrator(untuk file admin.php dan layers.php): 
 

 
 

12. Masukkan MySQL server dan OK (membetuk file connect.php): 
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13. Masukkan factor translation dan click OK (pilih antara 100-10000): 
 

 
 
14. Aplikasi akan mengexport tampilan peta dari ArcView dengan format bmg ke png 

(download aplikasi bmp2png terlebih dulu). 
 

 
 

15. Selanjutnya digunakan untuk setiap Layer yang aktif.  
 
16. (Hanya untuk unprojected View) Untuk point Layers jika inginmenghasilkan 

External data. 
 

 
 
Jika pilih yes, isi informasi dibawah ini: 

 

 
 

17. Jika tidak, maka pilih yes untuk atribut yang akan diexport: 
 

 
 

Jika pilih No data atribut tidak akan diexport. 
 

18. Pilih Legend type Single Simbol. 
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19. Pilih atribut untuk dijadikan Field name: 
 

 
 
20. Untuk melakukan design dengan External ID URL pada peta. 

 

 
 
21. Jika pilih yes: 

 

 
 

22. Design lokasi URL, menghasilkan: 
 

 
 

23. Pilih untuk memberi nama pada: 
 

 
 

24. Pilih fileds yang akan diexport sebagai attribut. Field pada Name Field yang dipilih 
tadi ikut disertakan. 
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25. Ulangi untuk setiap Layer yang aktif. 
26. Jika semua berjalan dengan baik maka akan muncul pesan: 

 

 

G.2.5 Setup di MySQL (Step 2) 
1. Buat database baru dengan nama seperti format(view_name). 

mysql> create database mexico; 
mysql> exit 

2. Import file dump yang dihasilkan pada step 1. 
 c:\mysql\bin> mysql mexico < mexico.sql 

3. Pastikan bahwa MySQL user account dibaca dan dituliskan kedalam database yang 
baru. 

G.2.6 Kirim Project ke Web Server (Step 3) 
1. Pastikan server memiliki php 4.0 atau versi terakhir. 
2. Menggunakan text editor, buka file connect.php. Muncul: 

<? 
  $db = mysql_connect("localhost", "root","password"); 
  mysql_select_db("view_name",$db); 
?> 

3. Kirim folder  tools dan file php, terdiri dari: 
a. map_frame.php  
b. map_page.php  
c. map.php  
d. legend.php  
e. loadSVG.php  
f. footer.htm  
g. connect.php 

4. Gunakan Internet Explorer 4.0+ dengan Adobe SVG Viewer plug-in, buka 
map_frame.php maka peta yang di export sudah dapat ditampilkan. Jika tidak ulangi 
step-step dan lakukan jangan sampai ada yang tertinggal. 

G.3 Database MySQL 
Database ini yang akan digunakan untuk aplikasi web hasil OpenSVGMapServer. 
 

Nama Tabel Nama Field Deskripsi 

ProjectID ID project 

Title Judul project 

Project 

(Informasi project) 

IsProjected 1 jika Project aktif, 0 jika tidak 
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Nama Tabel Nama Field Deskripsi 

LonMin* Digunakan jika project tidak aktif, Xminimal 

LonMax* Digunakan jika project tidak aktif, X maximal 

LatMin* Digunakan jika project tidak aktif, Y minimal 

LatMax* Digunakan jika project tidak aktif Y maximal 

Width Lebar peta dalam pixel 

Height Panjang peta dalam pixel 

Scale Skala peta 

 

AdminPassword Password untuk admin 

LayerID ID Layer 

Shape Bentuk Layer (point, line, polygon) 

Name Nama layer 

FillColor Warna yang digunakan untuk point dan polygon 

StrokeColor Warna garis digunakan untuk Line dan polygon 

StrokeWidth Lebar garis untuk line dan polygon 

MinScale Skala minimal, 0 jika tidak diset 

MaxScale Skala maksimal, 0 jika tidak diset 

HasAttributes 1 jika memiliki atribut, 0 jika tidak 

NameField Nama field dari table 

LabelColor Warna label 

LabelSize Ukuran label 

IDType Tipe ID 

ID field Nama Field dalam tabel 

URL Jika ID tipenya = “server” URL digunakan untuk 
memberi parameter pada ID field 

UseLabels 1 jika menggunakan label, 0 jika tidak 

IsExternal 0 jika layer tidak terbentuk dari external database, 1 
jika ya (digunakan untuk point) 

LegendType Single simbol untuk satu legend 

Layers 

(Informasi Layer 
dalam project) 

ClassificationField Nama field yang digunakan untuk klasifikasi legend 

ID ID sessions 
Sessions 

Date Inisialisasi tanggal 

SessionID Identifikasi untuk ID sessions, diambil dari field ID 
tabel sessions 

LayerID Identifikasi untuk ID layer, diambil dari field ID 
tabel layer Log 

FeatureID Identifikasi untuk ID feature, diambil dari field ID 
tabel featuresX 

FeatureID Identifikasi per Layer 

Geometry Geometry dari feature 

FeaturesX 

(line dan polygon) 

Xmin Nilai minimum X 
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Nama Tabel Nama Field Deskripsi 

Xmax Nilai maksimum X 

Ymin Nilai minimum Y 

Ymax Nilai maksimum Y 

 

(Ditambah field 
yang diexport 
sebagai atribut) 

- 

FeatureID Identifikasi per Layer 

Longitude Koordinat X 

Latitude Koordinat Y FeaturesX 

(point) (Ditambah field 
yang diexport 
sebagai atribut) 

- 

Keterangan:  
* Kadang digunakan 

G.4 Pola Data Dalam Tabel FeaturesX 
Pola data digital yang disimpan dalam tabel FeaturesX berbeda untuk setiap bentuknya.  

G.4.1 Point 

G.4.1.1 Field Longitude 
Tipe Data Double 
Contoh 1896.52 
Pola Diambil dari nilai  koordinat X pada objek point 

G.4.1.2 Field Latitude 
Tipe Data Double 
Contoh 3807.63 
Pola Diambil dari nilai koordinat Y pada objek point 

G.4.2 Line 

G.4.2.1 Field Geometry 
Tipe Data Longblob 
Contoh M 516000 122245 L 516544 122245 L 517088 122245 L 

517632 122245 L 518176 122245 L 518721 122245 L 
519265 122245 L 519809 122245 L 520353 122245 L 
520897 122245 L 521441 122245 L 521985 122245 L 
522529 122245 L 523074 122245 L 523618 122245 L 
524162 122245 L 524706 122245 L 525250 122245 L 
525794 122245 L 526338 122245 L 526882 122245 L 
527426 122245 L 527971 122245 L 528515 122245 L 
529059 122245 L 529603 122245 L 530147 122245 L 
530691 122245 L 531235 122245 L 531779 122245 L 
532324 122245 L 532868 122245 L 533412 122245 L 
533956 122245 L 534500 122245 L 535044 122245 L 
535588 122245 L 536132 122245 L 536676 122245 L 
537221 122245 L 537765 122245 L 538309 122245 L 
538853 122245 L 539397 122245 L 539941 122245 L 
540485 122245 L 541029 122245 L 541574 122245 L 
542118 122245 L 542662 122245 L 543206 122245 L 
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543750 122245 L 544294 122245 L 544838 122245 L 
545382 122245 L 545926 122245 L 546471 122245 L 
547015 122245 L 547559 122245 L 548103 122245 L 
548647 122245 L 549191 122245 L 549735 122245 L 
550279 122245 L 550824 122245 L 551368 122245 L 
551912 122245 L 552456 122245 L 553000 122245 

Pola M(untuk mengawali data) koordinat X koordinat Y L(untuk 
setiap pasangan koordinat) 

G.4.2.2 Field XMin 
Tipe Data Double 
Contoh 516000 
Pola Diambil dari nilai koordinat X paling kecil 

G.4.2.3 Field XMax 
Tipe Data Double 
Contoh 553000 
Pola Diambil dari nilai koordinat X paling besar 

G.4.2.4 Field YMin 
Tipe Data Double 
Contoh 122245 
Pola Diambil dari nilai koordinat Y paling kecil 

G.4.2.5 Field YMax 
Tipe Data Double 
Contoh 122245 
Pola Diambil dari nilai koordinat Y paling besar 

G.4.3 Polygon 

G.4.3.1 Field Geometry 
Tipe Data Longblob 
Contoh M 242361 126348 L 248394 127692 L 253086 123662 L 

257107 118289 L 259118 114931 L 259118 109558 L 
264480 109558 L 265821 108215 L 268502 106871 L 
269842 106871 L 272524 108886 L 275875 112916 L 
278556 114931 L 279226 117617 L 285929 118289 L 
291291 116946 L 295983 118961 L 297994 120304 L 
303356 119632 L 306707 120975 L 309389 121647 L 
312740 123662 L 316762 122319 L 322124 121647 L 
324135 125005 L 324135 129707 L 325475 134408 L 
323464 137766 L 324805 142467 L 324805 145825 L 
324805 149184 L 322794 151198 L 318772 153885 L 
315421 154556 L 312740 156571 L 312740 158586 L 
314080 164631 L 315421 165974 L 315421 167317 L 
315421 169332 L 313410 172019 L 310729 174033 L 
309389 175377 L 308048 176048 L 307378 180078 L 
308718 182765 L 311399 183436 L 311399 186123 L 
311399 189481 L 310059 194854 L 305367 194854 L 
306037 196197 L 307378 197540 L 309389 199555 L 
307378 200898 L 306715 199969 L 307063 202582 L 
309091 204905 L 309091 207227 L 305325 207808 L 
298950 204034 L 296921 205485 L 293734 205776 L 
292285 204324 L 292285 200549 L 289967 197065 L 
287939 197646 L 280405 190678 L 280405 184871 L 
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281237 184086 L 281237 181421 L 279897 178735 L 
277215 175377 L 275875 173362 L 274534 173362 L 
272524 174705 L 269842 173362 L 267161 167989 L 
267161 163288 L 266491 163288 L 263810 162616 L 
263810 159929 L 265821 158586 L 265821 155228 L 
264480 155228 L 263810 150527 L 263140 148512 L 
262469 144482 L 259788 145154 L 256437 143811 L 
255096 141124 L 256437 138438 L 256437 135751 L 
254426 137766 L 249064 137766 L 249064 135079 L 
249064 133065 L 249064 132393 L 247723 132393 L 
245713 132393 L 243702 133065 L 242361 131050 L 
242361 127692 L 242361 126348 z 

Pola M(untuk mengawali data) Koordinat  X koordinat Y 
L(untuk setiap pasangan koordinat) (Koordinat awal dan 
akhir sama) z(menyatakan polygon) 

G.4.3.2 Field XMin 
Tipe Data Double 
Contoh 242361 
Pola Diambil dari nilai koordinat X paling kecil 

G.4.3.3 Field XMax 
Tipe Data Double 
Contoh 325475 
Pola Diambil dari nilai koordinat X paling besar 

G.4.3.4 Field YMin 
Tipe Data Double 
Contoh 106871 
Pola Diambil dari nilai koordinat Y paling kecil 

G.4.3.5 Field YMax 
Tipe Data Double 
Contoh 207808 
Pola Diambil dari nilai koordinat Y paling besar 
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LAMPIRAN H LOGBOOK PERCOBAAN 

 
Untuk penggunaan legend standard pada sistem ini belum dapat dilakukan, karena untuk bentuk polygon 
pada peta jika diklik belum bisa menampilkan data.  
 
Beberapa hal yang telah dilakukan pada peta untuk menggunakan legend standard adalah dengan 
menggunakan bentuk legend yang terdapat pada ArcView, legend ini hanya ada jika menggunakan bentuk 
point pada ArcView. Pada saat diexport ke MySQL legend tersebut tidak tampil, karena sistem hanya 
mengenal point dalam bentuk titik.  
 
Hal berikutnya yang dilakukan dengan menganti bentuk point menjadi polygon, kemudian di atas bentuk 
polygon diisikan bentuk point agar jika diklik menampilkan data. Hal itu bisa dilakukan, tapi setelah diexport 
ke MySQL maka akan ada dua fasilitas umum yang sama dengan bentuk yang berbeda, pertama dalam 
bentuk point dan kedua dalam bentuk polygon. 
 
Seperti pada gambar: 
 

 
 

Pada gambar, ada dua fasilitas umum yang sama yaitu Rumahsakit, pertama dalam bentuk point dan yang 
kedua dalam bentuk polygon. 
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